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 警告
このマニュアルは，サービス専用です。
お客様が，このマニュアルに記載された設置や保守，点検，修理などを行うと感電や火災，
人身事故につながることがあります。
危険をさけるため，サービストレーニングを受けた技術者のみご使用ください。

 WARNING
This manual is intended for qualified service personnel only.
To reduce the risk of electric shock, fire or injury, do not perform any servicing other than that 
contained in the operating instructions unless you are qualified to do so. Refer all servicing to 
qualified service personnel.

 WARNUNG
Die Anleitung ist nur für qualifiziertes Fachpersonal bestimmt.
Alle Wartungsarbeiten dürfen nur von qualifiziertem Fachpersonal ausgeführt werden. Um die 
Gefahr eines elektrischen Schlages, Feuergefahr und Verletzungen zu vermeiden, sind bei 
Wartungsarbeiten strikt die Angaben in der Anleitung zu befolgen. Andere als die angegeben 
Wartungsarbeiten dürfen nur von Personen ausgeführt werden, die eine spezielle Befähigung 
dazu besitzen.

 AVERTISSEMENT
Ce manual est destiné uniquement aux personnes compétentes en charge de l’entretien. Afin 
de réduire les risques de décharge électrique, d’incendie ou de blessure n’effectuer que les 
réparations indiquées dans le mode d’emploi à moins d’être qualifié pour en effectuer d’autres. 
Pour toute réparation faire appel à une personne compétente uniquement.

Model Name Serial No.

HDC-P43 (SY) 10001 and Higher

HDC-P43 (J) 30001 and Higher

HDC-P43 (CN) 50001 and Higher

For safety, do not connect the connector for peripheral 
device wiring that might have excessive voltage to the 
following port(s).
: NETWORK TRUNK
Follow the instructions for the above port(s).

安全のために，周辺機器を接続する際は，過大電圧を
持つ可能性があるコネクターを以下のポートに接続し
ないでください。
：NETWORK TRUNK
上記のポートについては本書の指示に従ってください。

Use of controls or adjustments or performance 
of procedures other than those specified herein 
may result in hazardous radiation exposure.

CAUTION

CLASS 1 LASER PRODUCT
LASER KLASSE 1 PRODUKT
LUOKAN 1 LASERLAITE
KLASS 1 LASER APPARAT

This Multi Purpose Camera is classified as a CLASS 1 
LASER PRODUCT.
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CAUTION

Danger of explosion if battery is incorrectly replaced.
Replace only with the same or equivalent type rec-
ommended by the manufacturer.
When you dispose of the battery, you must obey the 
law in the relative area or country.

ATTENTION

Il y a danger d’explosion s’il y a remplacement incor-
rect de la batterie. Remplacer uniquement avec 
une batterie du même type ou d’un type équivalent 
recommandé par le constructeur.
Lorsque vous mettez la batterie au rebut, vous devez 
respecter la législation en vigueur dans le pays ou la 
région où vous vous trouvez.

VORSICHT

Explosionsgefahr bei Verwendung falscher Batterien. 
Batterien nur durch den vom Hersteller empfohlenen 
oder einen gleichwertigen Typ ersetzen.
Wenn Sie die Batterie entsorgen, müssen Sie die 
Gesetze der jeweiligen Region und des jeweiligen 
Landes befolgen.

注意

指定以外の電池に交換すると，破裂する危険があり
ます。
必ず指定の電池に交換してください。
使用済みの電池は，国または地域の法令に従って
処理してください。

FÖRSIKTIGHET!

Fara för explosion vid felaktigt placerat batteri.
Byt endast mot samma eller likvärdig typ av batteri, 
enligt tillverkarens rekommendationer.
När du kasserar batteriet ska du följa rådande lagar 
för regionen eller landet.

PAS PÅ

Fare for eksplosion, hvis batteriet ikke udskiftes 
korrekt.
Udskift kun med et batteri af samme eller tilsvarende 
type, som er anbefalet af fabrikanten.
Når du bortskaffer batteriet, skal du følge 
lovgivningen i det pågældende område eller land.

HUOMIO

Räjähdysvaara, jos akku vaihdetaan virheellisesti.
Vaihda vain samanlaiseen tai vastaavantyyppiseen, 
valmistajan suosittelemaan akkuun.
Noudata akun hävittämisessä oman maasi tai 
alueesi lakeja.

FORSIKTIG

Eksplosjonsfare hvis feil type batteri settes i.
Bytt ut kun med samme type eller tilsvarende 
anbefalt av produsenten.
Kasser batteriet i henhold til gjeldende avfallsregler.
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Manual Structure

Purpose of this manual

This manual is intended for the use of the system engineers and the service engineers, and provides the limited
information for block service and the information related to maintenance of the unit, service overview, periodic
maintenance and inspection, diagnosis, replacement of main parts, electrical alignment, software upgrade, file system,
setup menu, circuit description, etc.

Related manuals

The following manuals are available for this model.
If any of these manuals is required, please contact your local Sony Sales Office/Service Center.

• Operating Instructions CD-ROM (supplied with the unit)
This manual contains information required to operate and use the unit.

• Factory Service Manual (available on request)
This manual provides the limited information for component service and the information related to maintenance
of the unit.

Trademarks

Trademarks and registered trademarks described in this manual are as follows.
• FRAM is a registered trademark of Ramtron International Corporation.

Other system names and product names written in this manual are usually registered trademarks or trademarks of
respective development manufacturers.

Non-disclosed boards

Following boards cannot be replaced on the board-level service or part-level service.

If parts become defective, replace the entire OHB assembly or FD assembly.
• BI-291 board (included in OHB assembly)
• SE-1093 board (included in FD assembly)
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Section 1
Service Overview

1-1. Checking before Installation

1-1-1. Checking the ROM and Software Version

When connecting the peripheral equipment in the list below to this unit, be sure to check that the ROM and software
version on each peripheral device is corresponding to the camera to be connected.
If the ROM and software version is lower than the specified below, be sure to perform ROM replacement and updating
the software.
If ROM replacement and updating the software are required, contact your local Sony Sales Office/Service Center.

ROM

Peripheral Equipment Board Name Ref. No. ROM Version

CNU-700 AT-89 board or AT-89A board IC4, IC5 Ver. 1.30 and higher

Software

Peripheral Equipment Board Name Software Version

RCP-1500/1501/1530 MPU-153 board Ver. 2.91 and higher

HDCU2000/2500 AT-167A board Ver. 2.52 and higher

MSU-1000 MPU-150 board Ver. 2.91 and higher

MSU-1500 MPU-151 board Ver. 2.91 and higher

BPU4000 AT-189 board Ver. 3.31 and higher

BPU4500 AT-189H board Ver. 1.32 and higher

HDCU4300 AT-189K board Ver. 1.21 and higher
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1-2. Screw Positions for Mounting and Hanging

Unit: mm

Top view

37123

26

48 89

10

4-M2.6 4-M3 (*)

178

30

45

264470 47 49
.5

76

• There are screw positions of 4-M3 (*) only on upper panel, other screw positions are the same dimensions with
the top panel and the bottom panel.

• Other than M2.6 and M3 screws are using M4 screws.
• Use the screws (M2.6, M3, M4) of the length 5 mm for body. (thread depth: 5 mm)
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1-3. Connectors and Cables

1-3-1. Input and Output Signals of the
Connectors

9

1

5

4

3

2

7

8

6

Input Connectors

1. DC IN

1

2 3

4

- External View -

XLR 4-pin, Male

No. Signal I/O Specifications

1 EXT DC (C) — GND for DC (+)

2 NC — No connection

3 NC — No connection

4 EXT DC (H) IN +10.5 to +17.0 V DC

Output Connectors

2. PROMPTER OUT
BNC type, 75 Ω, 1.0 V p-p, unbalanced

3. SDI 1
BNC type
HD SDI signal
SMPTE 292M/372M, BTA-S004 compliant
0.8 Vp-p 75 Ω, 1.485 Gbps/1.4835 Gbps serial

Input and Output Connectors

4. SDI 2
BNC type

• Output:
3G SDI signal
SMPTE 424M/425M-B compliant
0.8 Vp-p 75 Ω, 2.97 Gbps/2.9679 Gbps serial
or HD SDI signal
SMPTE 292M/372M, BTA-S004 compliant
0.8 Vp-p 75 Ω, 1.485 Gbps/1.4835 Gbps serial

• Input:
HD SDI signal
SMPTE 292M, BTA-S004 compliant
0.8 Vp-p 75 Ω, 1.485 Gbps/1.4835 Gbps serial

5. NETWORK TRUNK

8-pin, RJ-45, 10Base-T/100Base-TX/1000Base-TX

- External View -

8 1

No. Signal I/O Specifications

1 TRD + (0) IN/
OUT

Transmitted/Received
Data + (0)

2 TRD – (0) IN/
OUT

Transmitted/Received
Data – (0)

3 TRD + (1) IN/
OUT

Transmitted/Received
Data + (1)

4 TRD + (2) IN/
OUT

Transmitted/Received
Data + (2)

5 TRD – (2) IN/
OUT

Transmitted/Received
Data – (2)

Continued
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No. Signal I/O Specifications

6 TRD – (1) IN/
OUT

Transmitted/Received
Data – (1)

7 TRD + (3) IN/
OUT

Transmitted/Received
Data + (3)

8 TRD – (3) IN/
OUT

Transmitted/Received
Data – (3)

6. EXT I/O

- External View -

18

915

No. Signal I/O Specifications

1 UNREG OUT 10.5 V to 17 V, 1.5 A
(max)

2 UNREG
GND

— GND for UNREG

3 G-TALLY OUT Open Corrector: 10 mA
(max)

4 RX0 (–): for
RS-422A
RX0: for
RS-232C

IN TRUNK Data In

5 RX0 (+): for
RS-422A
RX1: for
RS-232C

IN TRUNK Data In

6 ASSIGN1 IN/OUT Digital IO
OUT: Open Collector
(max. 10 mA)
IN: GND

7 GND — —

8 MIC (X) IN –60 to –20 dBu/Balanced

9 R-TALLY OUT Open Corrector: 10 mA
(max)

10 GND — —

11 TX0 (–): for
RS-422A
TX0: for
RS-232C

OUT TRUNK Data Out

12 TX0 (+): for
RS-422A
TX1: for
RS-232C

OUT TRUNK Data Out

13 ASSIGN2 IN/OUT Digital IO
OUT: Open Collector
(max. 10 mA)
IN: GND

14 MIC GND — GND for MIC IN

15 MIC (Y) IN –60 to –20 dBu/Balanced

7. USB
USB 2.0 (Type A)

- External View -

1 4

No. Signal I/O Specifications

1 VBUS OUT USB Vcc (+5 V)

2 D+ IN/
OUT

USB+

3 D– IN/
OUT

USB–

4 GND — GND

8. IN/OUT
ST connector for single-mode fiber cables
10.692 Gbps/10.681 Gbps
Transmission signal: IN (BPU/CCU → CAMERA)

• Return Video
• Prompter Video
• Audio (PGM)
• NETWORK TRUNK
• RS422A/RS232C

Transmission signal: OUT (CAMERA → BPU/CCU)
• Camera Video
• Audio (MIC)
• HD-TRUNK
• NETWORK TRUNK
• RS422A/RS232C

9. LENS

- External View -

12-pin, Female

12 11

46

7 3

28
9 1

10

5

No. Signal I/O Specifications

1 RET VIDEO
ENABLE

IN ENABLE: 0 V
DISABLE: +5 V or
OPEN

2 VTR CTL IN ENABLE: 0 V
DISABLE: +5 V or
OPEN

3 GND — GND for UNREG

4 SERVO
MA/AT

OUT AUTO: +5 V
MANU: 0 V or OPEN

Continued
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No. Signal I/O Specifications

5 IRIS POSI-
TION

OUT +3.4 V (F16) to +6.2 V
(F2.8)

6 UNREG OUT +10.5 to +17.0 V

7 IRIS POSI-
TION

IN +3.4 V (F16) to +6.2 V
(F2.8)

8 IRIS AT/MA OUT AUTO IRIS: 0 V
MANU IRIS: +5 V

9 EXTENDER
ON/OFF

IN EX 2 ON: GND
EX 0.8 ON: 30 kΩ to
GND
OFF: OPEN

30 kΩ

EX 2 ON

EX 0.8 ON

10 ZOOM PO-
SITION

IN WIDE: 2 V
TELE: 7V

11 FOCUS
POSI
(LENS RX)

IN ∞: 7 V
Min: 2V

12 FOCUS
POSI
(LENS TX)

OUT —

1-3-2. Connectors and Cables

Connection made with the connectors during installation or
service, should be made with the connectors/complete cable
assemblies specified in the following list, or equivalent parts.

Connector Name Connectors and Cables

IN/OUT ST connector
or ST connector single-mode fiber cable

PROMPTER OUT
(BNC)

Plug, BNC (Part No.: 1-794-166-41)
or B-B Cable assembly (1.5 m optional)

SDI 1/2
(BNC)

Plug, BNC (Part No.: 1-794-166-51)
or 5C-FB coaxial cable/ Recommendation
manufactured by Fujikura

DC IN
(XLR 4-pin, Male)

XLR 4-pin, Female (Part No.: 1-508-362-00)
or ITT Cannon XLR-4-11C equivalent
or DC cable CCDD-X2 (2 m)

LENS
(12-pin, Female)

Connector 12-pin, Male (Part No.:
1-691-190-13)
or HIROSE HR10A-10P-12P equivalent

EXT I/O
(D-sub 15-pin, Fe-
male)

D-sub 15-pin, Male (Part No.: 1-506-582-11)
or JAE DE-15PF-N equivalent (Available
shell: JAE DE-C1-J10-R equivalent)

1-3-3. Note in Connecting Single-mode
Optical Fiber Cable

• When connecting the cables, turn off the power of the unit
and each equipment. Do not connect and disconnect the
cables while equipments are turned on.

• If there is dust or other contamination on the connection face
for the ST connector, transmission errors will occur. Be sure
to protect the connector with the cover when not in use.

• Connect the single-mode fiber cables as shown below so that
connecting destinations cross (IN to OUT, OUT to IN)
between this unit and the equipment.

This unit

Single-mode
fiber cables (1 pair) 

Equipment

IN

IN OUT
OUT

• It is recommendable to clean the optical contact portions of
all equipments before connecting this unit to equipments
with single-mode fiber cables.
For details on a cleaning method, refer to “2-4. Cleaning of
Connector/Cable”.
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1-4. Functions of Onboard Switches and LED Indicators

1-4-1. DPR-376 Board

D101

D102

D501 D502

D503 D
10

01
D

10
02

D
10

03
D

10
04

D
13

01

D
20

01

D3001

D
30

02

D
30

03
D

30
04

D
30

05

1

2

3

4

A C D EB

D1302
D1303
D1304
D1305

S1301

1

2

3

4

ABCDE

DPR-376 BOARD (A side) DPR-376 BOARD (B side)

Ref. No. Address Name Color Description Normal
State

D101 E4 (side A) POWER Yellow-
green

Lights when the power supply regulators (+3.2 V,
+5 V) on the board are normal.

Lit

D102 E4 (side A) Low-Volt Yellow-
green

Lights when the power supply regulators (+0.85 V,
+1.5 V, +2.5 V, +3.3 V) on the board are normal.

Lit

D501 A3 (side A) — Yellow-
green

Factory use Inconstant

D502 C3 (side A) — Yellow-
green

Factory use Inconstant

D503 A2 (side A) — Yellow-
green

Factory use Inconstant

D1001 C1 (side A) TDIS Red Factory use Off

D1002 C1 (side A) TFAULT Red Factory use Off

D1003 C1 (side A) MOD ABS Red Factory use Off

D1004 C1 (side A) RX LOS Red Factory use Off

D1301 E1 (side A) Conf-Done Red Off when FPGA (IC1001) normally completed
configuration.

Off

D1302 B1 (side B) — Yellow-
green

Factory use Inconstant

D1303 B1 (side B) — Yellow-
green

Factory use Inconstant

D1304 B1 (side B) — Yellow-
green

Factory use Inconstant

D1305 B1 (side B) — Yellow-
green

Factory use Inconstant

D2001 E1 (side A) — Yellow-
green

Factory use Off

D3001 E3 (side A) EXT Yellow-
green

Factory use Off

D3002 E3 (side A) PLL-NG Red Lights when the PLL is abnormal. Off

D3003 D3 (side A) LOCK2 Red Lights when the clock synthesizer (IC3021) is not
locked.

Off

Continued
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Ref. No. Address Name Color Description Normal
State

D3004 D3 (side A) REF2 Red Lights when the reference clock is not input to the
clock synthesizer (IC3021).

Off

D3005 D3 (side A) VCXO2 Red Lights when the VCXO clock is not input to the
clock synthesizer (IC3021).

Off

Note

Do not touch the unused switches.

Ref. No. Address Name Bit Description Factory Set-
ting

S1301 E4 (side B) — 1 Not used OFF

1-4-2. SY-449 Board

D
00

1

B CA B AC

S301

S
30

2 1

2

3

1

2

3

SY-449 BOARD (B side)SY-449 BOARD (A side)

Ref. No. Address Name Color Description Normal
State

D001 B1 (side A) Conf Done Red Off when FPGA (IC701) normally completed con-
figuration.

Off

Note

Do not touch the unused switches.

Ref. No. Address Name Bit Description Factory Set-
ting

S301 A1 (side B) — 1 Not used OFF

   2 Not used OFF

   3 Not used OFF

   4 Not used OFF

S302 A1 (side B) JTAG EN 1 Not used OFF
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1-5. Flexible Flat Cable and Coaxial Cable

1-5-1. Connector for Flexible Flat Cable and Fine-Wire Coaxial Cable

Refer to the installing location and type of connector for connecting the flexible flat cable and fine-wire coaxial cable.

Note

Be careful when disconnecting and connecting the connector as its handling differs depending on the shape of connector.

Location of Connectors

DPR-376 BOARD (A side)

C
N

00
2

C
N

00
5

CN001

CN301

CN200CN201

C
N

20
2

DPR-376 BOARD (B side)

SY-449 BOARD (A side)

CN300

IF-1307 BOARD (A side)

SW-1705 BOARD (B side)

CN-3896 BOARD (A side)

CN300

CN1002

CN001

CN101

Type of Connectors

Board Ref. No. Connector for Flexible Flat Cable Connector for Fine-Wire Coaxial Cable

CN-3896 CN001 — Type A

DPR-376 CN101 Type A —

 CN200 — Type B

Continued
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Board Ref. No. Connector for Flexible Flat Cable Connector for Fine-Wire Coaxial Cable

 CN201 — Type B

 CN202 — Type B

 CN300 — Type C

 CN1002 — Type B

IF-1307 CN300 — Type A

SW-1705 CN005 Type A —

SY-449 CN001 Type B —

 CN002 Type A —

 CN301 Type C —

1-5-2. Disconnecting and Connecting Flexible Flat Cable

Note

• Be very careful not to fold flexible flat cables. Life of flexible flat cable will be significantly shortened if it is
folded.

• Each flexible flat cable has conductive side and insulated side. If the flexible flat cable is connected in the wrong
orientation of the conductive side and the insulated side, the circuit will not function.

• Insert the flexible flat cable straight.
• Check that the conductive side of the flexible flat cable is not contaminated.

Type A

Disconnecting

Flexible flat cable

Connector

Latch
A

1. Open the latch of the connector in the direction of arrow A to unlock.
2. Disconnect the flexible flat cable.

Connecting

Insulated side Latch

Flexible flat cable

B
Connector

1. Insert the flexible flat cable firmly as far as it will go with the insulating surface facing front.
2. Close the latch of the connector in the direction of arrow B to lock the flexible flat cable.
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Type B

Disconnecting

Latch

A

Latch
A

Flexible flat cable

1. Open the latch of the connector in the direction of arrow A to unlock.
2. Disconnect the flexible flat cable.

Connecting

Latch

B

LatchBConductive 
side

Flexible flat cable

1. Insert the flexible flat cable firmly as far as it will go with the conductive side up.
2. Close the latch of the connector in the direction of arrow B to lock the flexible flat cable.

Type C

Disconnecting

A

Flexible flat cable
Connector

Latch

1. Open the latch of the connector in the direction of arrow A to unlock.
2. Disconnect the flexible flat cable.

Connecting

B Flexible flat cable
Connector

Latch

Insulated side

1. Insert the flexible flat cable firmly as far as it will go with the insulated side up.
2. Close the latch of the connector in the direction of arrow B to lock the flexible flat cable.
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1-5-3. Disconnecting/Connecting Fine-Wire Coaxial Cable

Note

• Be very careful when handling the fine-wire coaxial cable so that fine wires are not disconnected.
• When disconnecting the fine-wire coaxial cable, be sure to hold the connector. Do not attempt to pull the cable.
• Check that the contact surface of the fine-wire coaxial cable connector is not contaminated.

Type A

Disconnecting

Fine-wire coaxial cable

Hold the connector to disconnect.

Do not attempt to disconnect by
pulling the cable.

OK

NG

Both sides of connector

1. Hold both sides of the fine-wire coaxial cable connector, and pull the connector in the arrow direction to disconnect
it.

Connecting

Fine-wire coaxial cable

Both sides of connector

1. Insert the connector of fine-wire coaxial cable in the arrow direction to connect it.

Note

Insert firmly the connector of fine-wire coaxial cable in the interior.
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Type B

Disconnecting

Connector

Connector

Fine-wire coaxial cable

Hold the connector to disconnect.

Do not attempt to disconnect by
pulling the cable.

OK

NG

1. Hold both sides of the fine-wire coaxial cable connector, and pull the connector straight to disconnect it.

Connecting

Connector

Connector

Fine-wire coaxial cable

1. Insert the connector straight.

Type C

Disconnecting

Hold the connector to disconnect.

Do not attempt to disconnect by
pulling the cable.

OK

NG

A

Connector

Pull-bar

Fine-wire 
coaxial cable

1. Raise the pull-bar in the direction of arrow A to unlock it.
2. Hold both sides of the fine-wire coaxial cable connector, and pull the connector straight to disconnect it.
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Connecting

B

Less than 5°

Less than 2°

Angle regulationPull-bar

Pull-bar

Contact surface

Connecting connector
Fine-wire coaxial cable

Fine-wire coaxial cable

Note

Insert the connector carefully so that the connector guides are not caught by the edge of the mating connector.

1. Hold both sides of the fine-wire coaxial cable connector with the contact surface facing up.
2. Insert the connector straight to meet the angle specified.
3. Turn the pull-bar in the direction of arrow B and lock it.
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1-5-4. Disconnecting/Connecting Coaxial Cable

Note

Be sure to hold the plug when disconnecting the coaxial cable. Do not pull the cable.

Disconnecting

Do not pull the cable.NGHold the plug to remove. OK

1. Hold the plug of the coaxial cable.
2. Pull the plug straight in the arrow direction to disconnect the coaxial cable.

Connecting

Hold the plug to connect.

Connecting connector

1. Hold the plug of the coaxial cable.
2. Push the plug perpendicularly to the connector while slightly turning the plug clockwise and counterclockwise.
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1-6. Circuit Protection Parts

1-6-1. Circuit Protection Element

This unit is equipped with positive-characteristic thermistors (power thermistors) as circuit protection elements.
The positive-characteristic thermistor limits the electric current flowing through the circuit as the internal resistance
increases when an excessive current flows or when the ambient temperature increases.
If the positive-characteristic thermistor works, turn off the main power of the unit and inspect the internal circuit of the
unit. After the cause of the fault is eliminated and the positive-characteristic thermistor is cooled down, turn on the main
power again. The unit works normally. It takes about one minute to cool down the positive-characteristic thermistor
after the main power is turned off.

Board Ref. No. Address Part No. Holding Current

LE-411 TH001 B1 (side A) !  1-802-063-21 1.10 A/20 °C

TH002 B1 (side A) !  1-802-063-21 1.10 A/20 °C

SW-1705 TH002 A2 (side A) !  1-802-108-11 1.50 A/20 °C
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1-7. Fixtures/Measuring Equipments List

1-7-1. Service Tools

Part No. Name Usage/Note

J-6029-140-B Pattern box PTB-500 Camera adjustment

J-6252-540-B Bit set for torque screwdriver (size 2, 2.5,
3 nut driver, +2 mm, +2.6 mm, +3 mm bit)

Screw tightening

J-6325-400-A Torque screwdriver (3 kg•cm) (0.3•N m) Screw tightening

J-6252-510-A Torque screwdriver (6 kg•cm) (0.6•N m) Screw tightening

J-6252-520-A Torque screwdriver (12 kg•cm) (1.2 N•m) Screw tightening

J-6394-080-A Grayscale chart Transparent type (16:9), Camera adjustment

Commercially available Grayscale chart Reflective type (16:9), Camera adjustment

Commercially available Nut driver (size: 4mm, 5mm) hexagonal support tightening

Commercially available Hexagon box bit (size: 11mm) Nut tightening

Commercially available USB drive Upgrading software, writing and rewriting the PLD
internal data

1-7-2. Measuring Equipment

Use the calibrated equipment or equivalent as listed below for the adjustments.

Equipment Model name

4K waveform monitor Leader Electronics LV5490 (multi waveform monitor) or equivalent

4K color monitor Sony BVM-X300 or equivalent

Luminance meter Konica Minolta LS-110 or equivalent
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1-8. Explanation of Adhering Number

The CMOS imager adhering is managed by following mount assembly number.
Prism optical: A-2075-369-A
Mount assembly number (8-digit): A0000001 and higher
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1-9. Lead-free Solder

All boards mounted in this unit use lead-free solder. Be sure to use lead-free solder when repairing the boards of this
unit. A lead free mark (LF) indicating that the solder contains no lead is printed on each board. (Caution: Some printed
circuit boards may not come printed with the lead free mark due to their particular size.)

: LEAD FREE MARK

Note

• The lead-free solder melts at a temperature about 40 °C higher than the ordinary solder, therefore, it is recommended
to use the soldering iron having a temperature regulator.

• The ordinary soldering iron can be used but the iron tip has to be applied to the solder joint for a slightly longer
time. The printed pattern (copper foil) may peel away if the heated tip is applied for too long, so be careful.
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Section 2
Periodic Maintenance and Inspection

2-1. Recommended Replacement Parts

This section describes the recommended replacement parts and recommended replacement time.
The replacement period of each part is changed according to the environment and condition. The parts made of rubber
used for this unit may become cracked and split with the lapse of time, therefore also replace it if necessary.

1

2

4

7

6

5

3

No. Part name Part No. Recommended replacement timing

1 Optical filter unit 1-856-701-11 It can become nebulous (in transparent and whitened)
with elapse of time. Replace it as necessary.

2 Bayonet ring 4-263-184-04 Replace every 5 years.

3 Lens mount holder 3-796-982-03 Check for deformation and deterioration (abraded or
damaged or lost) from time to time. Replace it as nec-
essary.

4 ST connector cap 4-579-333-01  

5 Fan cushion 4-689-064-01  

6 DC fan (60 square) !  1-855-154-11 Check every five years and replace it if necessary.
(When used for eight hours a day.)

7 PS-921 board A-2178-389-A It is recommended that replace it when energizing time
has elapsed about 25,000 hours.
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2-2. Cleaning the Air Vents

Clogging of dust or foreign matters may cause a temperature increase inside the camera, which may result in a failure.
Clean the air vents every two or three months.

Procedure
1. Remove dust on the four air vent areas with a vacuum cleaner.

Air vent

Air vents

Air vent
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2-3. Replacing Lithium Battery

2-3-1. Note on Replacement of Lithium Battery

A lithium battery is mounted on the SY-449 board to back up the real time clock (RTC).
If this unit is not energized, the backup period is about two years. When the RTC is reset without using this unit for long
time, charge the lithium battery by energizing this unit all day long.
When the backup period is shortened even if the lithium battery is charged, the lithium battery must be replaced.

• Replacement part: Lithium secondary battery (ML621 (U))
• Part number: !  1-756-134-16

Note on Replacement of Lithium Battery
CAUTION

When replacing the lithium battery, ensure that the battery is installed with “+” and “-” poles connected to
the correct terminals. Improper connection may cause an explosion or leakage of fluid, resulting in injury
or damage to surrounding properties.

2-3-2. Replacing Lithium Battery

1. Remove the SY-449 board. (Refer to “4-15. SY-449 Board”.)
2. Remove the Lithium secondary battery (ML621 (U)) from the four hooks of the battery holder, and replace it.

Lithium secondary battery

Hooks

Hooks

SY-449 board

Note

Be sure to use an insulating stick to remove the Lithium secondary battery (ML621 (U)).

3. Install the removed parts by reversing the steps of removal.
4. The date and time in the internal clock to be set. (For setting method, refer to Operation Manual.)
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2-4. Cleaning of Connector/Cable

The photo receptive condition of the optical connector can be checked by Camera Control Unit (CCU), Baseband
Processor (BPU) and camera that is connected to this unit.

• When two green indicators lit: Reception is very good
• When one green indicator lit: Reception is good
• When the yellow indicator lit: Reception is poor
• When the red indicator lit: Reception is very poor.

When lit in red, be sure to clean the optical contact portions.
When lit in yellow, cleaning is recommended.
The attenuation of the photo-receptive level may cause transmission error. Clean optical contact portions proceeding as
follows.

Note

The optical contact portion exists in the optical connector on the camera or camera control unit, and in the optical/
electrical cables. Clean the connected optical contact portion all equipment.
The cleaning method of the unit is describes on the following. For other equipment, refer to the service manual of the
equipment to be connected.

2-4-1. When the Optical Connector Cleaner (Commercially Available) is
Available

Tool and Fixtures 

• Optical connector cleaner (commercially available)
- Product name: CLETOP ®

- 14100402 or 14100403 (stick type) or equivalent
- 14100402: 2.0 mm
- 14100403: 2.0/2.5 mm double ended

Tip

• Alcohol is not necessary during cleaning.
• Number of possible wipes is one cleaning per a piece. Do not reuse it.

Cleaning of ST Connectors Single-mode Fiber Cable

Clean the tip of the white optical contacts using the optical connector cleaner.

ST connector single-mode
fiber cable

ST connector section

Tip of the ST connector section

CAP
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Cleaning of Connector

Clean the tip of the white optical contacts using the optical connector cleaner.

Optical contact 
(white)

2-4-2. When the Optical Connector Cleaner (Commercially Available) is not
Available (Connector)

Fixtures

• Alcohol (commercially available)
• Cotton swabs (commercially available)

Note

Use a cotton swab whose diameter is about 4 mm. If a cotton swab whose diameter exceeds 5 mm is used, the
cotton swab cannot be inserted into the end of the connector and the tip of the optical contact cannot be cleaned.

Connector

Clean the tip of the white optical contacts with a cotton swab moistened with alcohol.

Optical contact (white)
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Section 3
Diagnostics

3-1. Device Check

This unit is provided with a self-diagnosis function for checking the communication function of each device.
Diagnosis result can be monitored on the BOARD STATUS page of the DIAGNOSIS menu.

3-1-1. BOARD STATUS (DIAGNOSIS menu)

When “NG” is displayed on this page, there may be a problem with the relevant device or its connection.

<BOARD STATUS>   D02 TOP

 OHB : OK
 DPR : OK
 SY  : OK
 PS  : OK

 HOURS METER : xxxx H

Item Setting: Function

OHB Display only Indicates the status of the LSI (IC005) on the BI-291 board.

DPR Display only Indicates the status of the LSI (IC1001) on the DPR-376 board.

SY Display only Indicates the status of LSI (IC701) on the SY-449 board.

PS Display only Indicates the status of power supply on the PS-921 board.

HOURS METER Display only Displays the total working time.

3-1-2. Displaying

1. Turn the DISPLAY/MENU switch to the MENU side while pressing the MENU SEL knob/ENTER button.
[TOP] appears at the upper right of the screen of the monitor connected to SDI 1 connector.

2. Set the cursor at [TOP] and press the MENU SEL knob/ENTER button.
The TOP MENU screen showing the entire configuration of menu items appears.

3. Set the cursor to [DIAGNOSIS] and press the MENU SEL knob/ENTER button.
4. Set the cursor to [BOARD STATUS] and press the MENU SEL knob/ENTER button.
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3-2. Troubleshooting

3-2-1. Camera picture does not appear

When using the camera control unit HDCU4300

Camera picture 
does not appear.

Yes

No

Confirm OPTICAL LEVEL 
page in DIAGNOSIS menu 
of camera.

Is light sensor 
level at optical connector 

appropriate?

Clean the optical contact 
portions of optical connector.

End
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When using the baseband processor unit BPU4000/BPU4500

Camera picture 
does not appear.

Yes

No

Confirm OPTICAL LEVEL 
page in DIAGNOSIS menu 
of camera.

Confirm CURRENT of
CHU MODE page in 
CONFIGURATION menu 
of BPU4000/BPU4500.

Yes

No

Is light sensor 
level at optical connector 

appropriate?

Yes

NoIs the camera 
system configured with extension 

mode?

Yes

Is the camera 
extension adapter HDCE-100 

connected to the camera system 
and is the power 

turned on?

Clean the optical contact 
portions of optical connector.

No Connect the HDCE-100 to 
the camera system, and 
turn on the power. 

Is HDC-P43 selected ?

End

Set camera head setting to 
HDC-P43.
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3-2-2. HD SDI signal is not output normally from SDI 1 connector

HD SDI signal is not output 
normally from SDI 1 connector.

End

Is it set to 
MAIN(i)?

Yes

No
Set it to MAIN(i).

Confirm SDI-1 OUT of SDI OUT 
page in MAINTENANCE menu 
of camera.

3-2-3. The levels of G and B are changed after changing R-ch at white balance
adjustment

Levels of G and B are changed 
after changing R-ch at white 
balance adjustment.

End

Is it set to 
NORMAL?

Yes

No
Set it to NORMAL.

. When using the HDCU4300
 Confirm SLOT1/COLOR SPACE of 
 D-RANGE/COLOR SPACE page in 
 SYSTEM OPERATION menu.

. When using the BPU4000/BPU4500
 Confirm 4K COLOR SPACE of 
 BPU MODE page in 
 CONFIGURATION menu.
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3-2-4. Camera does not turn on

Yes

No

No

Yes

Yes

No

Camera does not turn on.

Does 
POWER LED of 

AC adapter (AC-DN10) 
turn on?

Does POWER 
LED of CAMERA 

turn on?

End

Does camera 
turn on?

Confirm the connection of AC input cable.

End

Remove the accessories attached to the 
camera, turn on in the following sequence:  
AC adapter and camera.
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Section 4
Replacement of Main Parts

4-1. Precautions before Work

4-1-1. Tightening Torque

When tightening screws used in this unit, be sure to use a torque driver and tighten screws to the specified tightening
torque.
If the specified tightening torque is described in the figure in this section, tighten screws to the specified tightening
torque in the figure.

Tightening torque
M2 : 0.30 ±0.03 N·m
M2.6 : 0.53 ±0.07 N·m
M3: 0.80 ±0.12 N·m

Tip

When using the torque driver with the notation of cN·m, interpret it as follows.
Example: 0.8 N·m = 80 cN·m
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4-2. Location of Printed Wiring Boards

IF-1278 board

DR-663 board

AT-189V board

LE-411 board

DPR-376 board

IF-1307 board

CN-3883 board

CN-3896 board

SW-1705 board

PS-921 board

SY-449  board
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4-3. Actions to be Taken during Board Replacement and after Board
Replacement or after Board Repair

4-3-1. Stored Data of ICs

The table below lists data retained in the IC on the following boards.
When any of the following boards or ICs is replaced, deal with action to be taken in replacing parts.

Note

The part number listed in “Spare Parts” is for IC which is not programmed. If replacement is needed, contact your local
Sony Sales Office/Service Center.

Board Ref. No.
(Type)

Stored Data Replacement and Actions

AT-189V IC401
(eMMC)

Software program Replacement of the board (not replacing IC)
Necessary (refer to “6-1. Upgrading Software Programs”.)

DPR-376 IC109
(EEPROM)

Model information data Replacement of the board
Remove the IC attached to the former board and replace it
to the new board.

IC1303
(Flash)

PLD data Replacement of the board (not replacing IC)
Necessary (refer to “6-2. PLD”.)

IF-1278 IC204
(Flash)

CMOS adjustment data, RPN com-
pensation data

Replacement of the board (not replacing IC)
Necessary (refer to “4-3-2. Alignment and Setting Required
when Replacing IF-1278 Board”.)

SY-449 IC403,
IC404
(FRAM)

Paint data, etc. Replacement of the board (not replacing IC)
Necessary (refer to “4-3-3. Alignment and Setting Required
when Replacing SY-449 Board”.)

 IC804
(Flash)

PLD data Replacement of the board (not replacing IC)
Necessary (refer to “4-3-3. Alignment and Setting Required
when Replacing SY-449 Board”.)

4-3-2. Alignment and Setting Required when Replacing IF-1278 Board

1. Replace the IF-1278 board.
(Refer to “4-9. IF-1278 Assembly”.)

2. Compensate the RPN.
(Refer to “5-6. RPN Compensation”.)

3. Make electrical adjustment as needed.
(Refer to “5. Electrical Alignment”.)

4-3-3. Alignment and Setting Required when Replacing SY-449 Board

Camera setting status and files are stored in the SY-449 board. When the SY-449 board is replaced, contents of the
reference file, scene file, lens file, and operator file are lost. Store these files in a USB drive and then replace the SY-449
board.
The content of the OHB file stored in the OHB assembly is not lost.

Procedure
1. Store the operator file, scene file, and reference file in a USB drive.

• Operator file (Refer to “7-2. Operator File”.)
• Scene file (Refer to “7-4. Scene File”.)
• Reference file (Refer to “7-5. Reference File”.)
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2. Replace the SY-449 board.
(Refer to “4-15. SY-449 Board”.)

3. Upgrade the PLD data.
(Refer to “6-2. PLD”.)

4. Execute ALL PRESET on the REFERENCE page of the FILE menu.
(Refer to “7-5. Reference File”.)

5. Execute STORE FILE on the REFERENCE page of the FILE menu.
(Refer to “7-5. Reference File”.)

6. Execute the automatic adjustment.
(Refer to “5-2. Automatic Adjustment”.)

7. Load the operator file, scene file, and reference file stored in the USB drive in step 1.
• Operator file (Refer to “7-2. Operator File”.)
• Scene file (Refer to “7-4. Scene File”.)
• Reference file (Refer to “7-5. Reference File”.)

8. Readjust the lens and OHB.
(Refer to “7-6. Lens File”, “7-7. OHB File”.)
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4-4. Side Panel, Bottom Cover

Procedure
1. Remove the side panel (L), side panel (R) and bottom cover.

(1) Remove the six screws (B2 x 5) and remove the side panel (L).
(2) Remove the six screws (B2 x 5) and remove the side panel (R).
(3) Remove the four screws (B3 x 10), tilt the rear panel assembly in the direction of the arrow, and release the

hole of the bottom cover from the boss of the rear panel assembly.
(4) Release the two holes of the bottom cover from the two bosses of the front panel assembly, and then remove

the bottom cover.

B3 x 10

B2 x 5

B2 x 5

B3 x 10

Bottom cover

Side panel (L)

Side panel (R)

Rear panel assembly

Boss

Bosses

Hole

Holes

2. Install the removed parts by reversing the steps of removal.
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4-5. DPR-376 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
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Procedure
1. Remove the DPR radiation plate, and disconnect the cables.

(1) Remove the four screws (PSW3 x 8) and the screw (PSW2 x 5), and then remove the DPR radiation plate.
(2) Disconnect the two optical fiber cables from the two connectors of the optical module on the DPR-376 board.
(3) Disconnect the two fine-wire coaxial cables from the two connectors (CN201(G), CN200 (R)) on the DPR-376

board.

2

1

PSW2 x 5

PSW3 x 8 Fine-wire coaxial cable
(DPR-BI (30))(G)

Fine-wire coaxial cable
(DPR-BI (30))(R)

DPR-376 board

DPR radiation plate

CN200 (R)

CN201 (G)

Optical fiber cable
(OUT) (Mark: 1)

Optical fiber cable
(IN) (Mark: 2)

(Tightening torque: 0.53N·m)

Note

When connecting the optical fiber cable, pay attention as follows.
• Connect after cleaning the tip of optical connector.
• Confirm the marks (1, 2) of connectors, and connect correct connectors.

Note

When connecting the fine-wire coaxial cable, pay attention as follows.
• Connect correct connectors.
• Carefully handle these fine-wire coaxial cables so that they are not disconnected.

Fine-wire coaxial cable
(DPR-BI (30))(R)

Fine-wire coaxial cable
(DPR-BI (30))(B)

Fine-wire coaxial cable
(DPR-BI (30))(G)
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2. Remove the DPR-376 board.
(1) Remove the two screws (PSW2 x 5).
(2) Disconnect the connector (CN102) on the DPR-376 board from the connector (CN100) on the IF-1307 board

and open the DPR-376 board in the direction of the arrow.

PSW2 x 5

CN100 (IF-1307 board)

CN102

DPR-376 board
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3. Remove the parts on the DPR-376 board.
(1) Disconnect the fine-wire coaxial cable from the connector (CN202 (B)) on the DPR-376 board.
(2) Disconnect the flexible flat cable (50 core) from the connector (CN101) on the DPR-376 board.
(3) Disconnect the two harnesses from the two connectors (CN1401, CN1402) on the DPR-376 board.
(4) Disconnect the harness from the connector (CN300) on the DPR-376 board.
(5) Remove the two screws (PSW2 x 5), and then remove the DPR-IN heat sink.

PSW2 x 5

Harness (DPR-IF)

DPR-IN heat sink

CN202 (B)CN101

CN300

CN1401

CN1402

Hole

Hole

Hole

Hole

Harness (DPR1)

Bosses

Boss

Harness (DPR2)

Flexible flat cable (50 core)

Fine-wire coaxial cable
(DPR-BI (30))(B)

4. Turn the lever and remove the optical module (SFP+).

Optical module (SFP+)

DPR-376 board

Lever
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5. Install the removed parts by reversing the steps of removal.

Note

When attaching the DPR-IN heat sink, hook the hook of the DPR-IN heat sink to the notch of the DPR-376 board.

DPR-IN heat sink
DPR-376 board

Note

When attaching the DPR radiation plate, install the screw (PSW3 x 8) at the position shown below with the bottom
cover attached.

Bottom cover

DPR radiation plate

PSW3 x 8
(Tightening torque: 0.53N·m)
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4-6. Front Panel Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)

Procedure
1. Remove the front assembly.

(1) Disconnect the harness from the connector (CN003) on the SY-449 board, and release the harness from the
clamper.

(2) Disconnect the harness from the connector (CN005) on the PS-921 board.
(3) Remove the two screws (B3 x 10), and then draw the front panel assembly in the direction of the arrow.
(4) Disconnect the harness from the connector (CN010) on the PS-921 board, and release the harness (CIS-PWR)

from the clamper, and then remove the peel off the tape AS.
(5) Remove the front panel assembly.

SY-449 board

Front panel assembly

B3 x 10

Clamper

Clamper

Tape AS

Harness (CIS-PWR)

PS-921 board

CN005

CN003

CN010

Harness (front)

Harness

Rear panel assembly

2. Install the removed parts by reversing the steps of removal.
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4-7. OHB Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)

Procedure
1. Remove the four HEXAGON screws and the four spring washers (SW3), and then remove the OHB assembly.

OHB assembly

Front panel assembly

HEXAGON M3 x 8

Washers (SW 3)

(Tightening torque: 1.1N·m)

2. Install the removed parts by reversing the steps of removal.
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4-8. FD Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the OHB assembly. (Refer to “4-7. OHB Assembly”)

Procedure
1. Remove the FD assembly.

(1) Remove the two screws, and then draw the FD assembly in the direction of the arrow.
(2) Disconnect the harness from the connector (CN006) on the IF-1278 board.
(3) Remove the FD assembly.

Attached screw in the FD assembly

CN006

Harness (FT-I2C)

FD assembly

(Tightening torque: 0.53N·m)

2. Install the removed parts by reversing the steps of removal.
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4-9. IF-1278 Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the OHB assembly. (Refer to “4-7. OHB Assembly”)
5. Remove the FD assembly. (Refer to“4-7. OHB Assembly”)

Procedure
1. Remove the IF-1278 board.

(1) Disconnect the three flexible flat cables from the three connectors (CN001, CN002, CN003) on the IF-1278
board.

(2) Disconnect the two harnesses from the two connectors (CN004, CN005) on the IF-1278 board.
(3) Remove the four screws (PSW2 x 5), and then remove the IF-1278 board.

PSW2 x 5

PSW2 x 5

IF-1278 board

Flexible flat cable (BI-IF)
Bosses

Holes

Flexible flat cable (BI-IF)

Flexible flat cable (BI-IF)

 Harness (DPR-IF)

Harness (CIS-PWR)

CN003

CN002

CN004

CN005

CN001

2. Install the removed parts by reversing the steps of removal.
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4-10. LE-411 Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the OHB assembly. (Refer to “4-7. OHB Assembly”)

Procedure
1. Remove the LE-411 board.

(1) Disconnect the two harnesses from the two connectors (CN002, CN003) on the LE-411 board.
(2) Remove the three screws (PSW2 x 5), and then remove the LE-411 board.

Front panel assembly

PSW2 x 5

Harness

Harness

CN003

CN002
LE-411 board

2. Install the removed parts by reversing the steps of removal.
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4-11. PS-921 Board

Preparation
1. Remove the side panel (R). (Refer to“4-4. Side Panel, Bottom Cover”)

Procedure
1. Remove the PS-921 board.

(1) Disconnect the seven harnesses from the seven connectors (CN002, CN004, CN005, CN007, CN008, CN009,
CN010) on the PS-921 board.

(2) Remove the four screws (PSW2 x 5), and then remove the PS-921 board.

PSW2 x 5

PSW2 x 5

PS-921 board

Harness (XLR)

Harness (REAR)

Harness (DPR1)

Harness (DPR2)

Harness (SY)

Harness (CIS-PWR)

Harness (front)

CN005

CN010

CN007

CN009

CN004

CN008

Bosses

hole

Hole

CN002

2. Install the removed parts by reversing the steps of removal.
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4-12. Rear Panel Assembly

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to“4-11. PS-921 Board”)

Procedure
1. Disconnect the cables.

(1) Remove the four screws (PSW2 x 5), and then remove the PS radiation block assembly.
(2) Disconnect the flexible flat cable from the connector (CN002) on the SY-449 board.
(3) Disconnect the two optical fiber cables from the SC-ST optical fiber adaptor.
(4) Release the harness (rear) from the clamper.

2

1

PSW2 x 5

PS radiation block assembly

CN002

Clamper

Boss

Boss

Hole

Hole

OUT

IN

Flexible flat cable

Harness (rear)

Harness (XLR)

Optical fiber cable
(IN) (Mark: 2)

Optical fiber cable
(OUT) (Mark: 1)

Note

When connecting the optical fiber cable, pay attention as follows.
• Connect after cleaning the tip of optical connector.
• Confirm the marks (1, 2) of connectors, and connect correct connectors.
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2. Remove the rear panel assembly.
(1) Disconnect the coaxial cable (blue) from the connector (J100) on the IF-1307 board.
(2) Disconnect the coaxial cable (red) from the connector (J101) on the IF-1307 board.
(3) Disconnect the fine-wire coaxial cable (CN-SDI-SS) from the connector (CN300) on the IF-1307 board.
(4) Remove the two screws (B3 x 10), and then draw the rear panel assembly in the direction of the arrow.
(5) Disconnect the harness from the connector (CN200), and then release the harness from the clamper.

IF-1307 board

CN200

J100 (blue)

J101 (red)

Fine-wire coaxial cable (CN-SDI-SS)

Harness

Clamper
Rear panel assembly

Coaxial cable (blue)

Coaxial cable (red)

CN300

B3 x 10

Note

When installing the rear panel assembly, pay attention as follows.
• When connect the coaxial cables, connect correct connectors.
• When connect the fine-wire coaxial cables, carefully handle these fine-wire coaxial cables so that they are

not disconnected.
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3. Install the removed parts by reversing the steps of removal.

Tip

Arrange the coaxial cables (blue) and (red), fine-wire coaxial cable (CN-SDI-SS), harness, flexible flat cable (50
core) as shown in the figure.

Flexible flat cable (50 core)

Clamper

Harness

Coaxial cable (blue)

Coaxial cable (red)
Fine-wire coaxial cable (CN-SDI-SS)
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4-13. DC Fan

When replacing the DC fan, also replace the two fan cushions.
• Fan cushion : 2 pcs

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)
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Procedure
1. Remove the DC fan block.

(1) Remove the two screws (PSW2 x 5), and then lift the DC fan block.
(2) Disconnect the harness from the connector (CN010) on the SW-1705 board.
(3) Remove the DC fan block.

Label

DC fan block

Holes

Boss
Boss

CN010

Harness

PSW2 x 5

Note

When attaching the DC fan block, arrange the harness.

Flexible flat cable

DC fan block
Harness SW-1705 board
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2. Remove the fan holder.

Fan holder

3. Attach two new fan cushions to a new DC fan.

Label

DC fan

Harness

Fan cushion

Fan cushion

Note

Install the fan cushion carefully paying attention to the label side and the harness position.

4. Reassemble the unit.
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4-14. AT-189 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)

Procedure
1. Remove the AT-189 board.

(1) Remove the two screws (PSW3 x 8).
(2) Disconnect the connector (CN100) on the AT-189 board from the connector (CN303) on the SY-449 board,

and then remove the AT-189 board.

PSW3 x 8

AT-189 board

CN303

CN100

SY-449 board

2. Install the removed parts by reversing the steps of removal.
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4-15. SY-449 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)
6. Remove the AT-189 board. (Refer to “4-14. AT-189 Board”)

Procedure
1. Remove the SY-449 board.

(1) Disconnect the flexible flat cable from the connector (CN001) on the SY-449 board.
(2) Disconnect the harness from the connector (CN004) on the SY-449 board.
(3) Remove the four screws (PSW2 x 5), and then remove the SY-449 board.

Flexible flat cable

SY-449 board

Boss

Boss

Hole

Hole

Harness

PSW2 x 5CN004

CN001
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2. Remove the lithium secondary battery.

Lithium secondary battery

Hooks

Hooks

SY-449 board

3. Install the removed parts by reversing the steps of removal.
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4-16. IF-1307 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)
6. Remove the AT-189 board. (Refer to “4-14. AT-189 Board”)
7. Remove the SY-449 board. (Refer to “4-15. SY-449 Board”)

Procedure
1. Remove the IF-1307 board.

(1) Release the two optical fiber cables from the two clampers.
(2) Remove the two clampers from the IF -1307 board.
(3) Remove the two screws (PSW2 x 5) and the two supports (2SQ-13), and then remove the IF-1307 board.

2

1

PSW2 x 5

IF-1307 board

Clampers

Boss

Hole

Hole

Boss

Optical fiber cables

Locking 
compound

Supports (2SQ-13)
(Tightening torque: 0.15N·m)

Note

When installing the supports (2SQ-13), apply locking compound to them.

2. Install the removed parts by reversing the steps of removal.
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4-17. SW-1705 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)
6. Remove the DC fan block assembly. (Refer to “4-13. DC Fan”)

Procedure
1. Remove the SW-1705 board.

(1) Release the harness from the clamper.
(2) Remove the two connector screws (M2.6 x 5) and the encoder knob.
(3) Remove the four screws (PSW2 x 5), and then remove the SW-1705 board.
(4) Remove the SW cap and the clamper.

Note

Be careful not to lose the SW cap.

Connector screws
(M2.6 x 5)

SW-1705 board

Bosses

Boss

Hole

Hole

SW cap

Harness (XLR)

Encoder knob

PSW2 x 5

Clamper
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2. Install the removed parts by reversing the steps of removal.

Note

When installing the SW-1705 board, arrange the harnesses and the fine-wire coaxial cables as shown in the figure.

Fine-wire coaxial cable

Fine-wire coaxial cable
(CN-SDI-SS)

Harness (rear)

Flexible flat cable

DC fan block assembly

Harness SW-1705 board

Harness (front) ClamperTape BT

Harness (XLR)
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4-18. CN-3883 Board, CN-3896 Board

Preparation
1. Remove the side panel (L), side panel (R) and bottom cover. (Refer to “4-4. Side Panel, Bottom Cover”)
2. Remove the DPR-376 board. (Refer to “4-5. DPR-376 Board”)
3. Remove the front assembly. (Refer to “4-6. Front Panel Assembly”)
4. Remove the PS-921 board. (Refer to “4-11. PS-921 Board”)
5. Remove the rear panel assembly. (Refer to “4-12. Rear Panel Assembly”)
6. Remove the DC fan block assembly. (Refer to “4-13. DC Fan”)
7. Remove the SW-1705 board. (Refer to “4-17. SW-1705 Board”)

Procedure
1. Remove the three screws (PSW3 x 8), and then remove the SC-ST optical fiber adaptor.
2. Remove the two screws (PSW2.6 x 5), and then remove the CN-3883 board.

SC-ST optical fiber adaptor

CN-3883 board

PSW3 x 8

P2.6 x 5
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3. Remove the CN-3896 board.
(1) Remove the four screws (PSW2 x 5) [A], and then remove the Ether bracket and the CN-3896 board together.
(2) Remove the two screws (PSW2 x 5) [B], and then remove the CN-3896 board.

Ether bracket

Bosses

Holes

Bosses

CN-3896 board

Holes

PSW2 x 5
[A]

PSW2 x 5
[B]

PSW2 x 5

4. Install the removed parts by reversing the steps of removal.
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Section 5
Electrical Alignment

When any board of this unit is repaired or replaced, adjust this unit for electrical alignment as this section.

Note

• Perform the “5-4. Video System Level Adjustment” according to the system that the customer uses.
• Master setup unit MSU-1000/1500 is used for electrical alignment of the unit.

Without using master setup unit (here after MSU), the electrical alignment also can be made using remote control
unit (RCP-1000/1500) or setting menu of the camera.
Refer to “5-1-7. Setup Menu Correspondence List” for detail of setup menu.

• Camera control unit HDCU4300 is used for electrical alignment of the unit.
Without using camera control unit, the electrical alignment also can be made using base band processor unit
(BPU4000/4500).

5-1. Preparations

Turn on the power switch before starting adjustments, and warm up the unit for about 10 minutes.

5-1-1. Required Equipment, Tool

Note

Use calibrated equipment and tools.

Equipment Required

Name Equipment

4K waveform monitor Leader Electronics LV5490 (multi waveform monitor) or equiv-
alent

4K color monitor Sony BVM-X300 or equivalent

Master setup unit Sony MSU-1000/1500

CCU extension adapter Sony HKCU-SM100

Camera control unit Sony HDCU4300

Baseband processor unit Sony BPU4000/4500

Camera extension adapter Sony HDCE-100
(Required when using the BPU4000/4500.)

Lens Canon HJ18 or equivalent

Tool

Name Sony Part No. Remarks

Grayscale chart (16 : 9 reflective type) — Commercially available
Since time degradation is appeared, replace for every two years.
(The exchange time, change by the safekeeping situation.)

Grayscale chart (16 : 9 transparent type) J-6394-080-A Use when the grayscale chart (16 : 9 reflective type) is not avail-
able.Pattern box PTB-500 J-6029-140-B
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5-1-2. File Data at Adjustment

The file structure of the adjustment data of this unit is as follows.

OHB

File data Total adjustment data

Scene

Lens
Reference

For detail of adjustment data, Refer to “7. File System”.

Reference File
• The reference file stores the custom paint data adjusted by the video engineer as standard paint data.
• The service engineer can store reference file in the camera and USB drive.
• The reference file stored in the USB drive(For back up) can be reset after adjustment.

Lens File
• Lens file is used for compensating the deviation generated by switching the lens extender from OFF to ON and

for compensating the difference in the characteristics between lenses.
• The lens file is saved to a camera.
• When adjusting with lens file, mount the lens that customer uses actually.

OHB File
• OHB file is used for the prism block maintenance.
• OHB file is saved in the camera.

5-1-3. Handling the Grayscale Chart

It is preferable to use an 89.9%-reflective grayscale chart for electrical adjustments.
If a reflective chart is not available, use a calibrated pattern box and a transparent grayscale chart for adjustments.
Before beginning adjustment, set the illumination of the light source (or the luminous intensity on the chart surface)
properly proceeding as follows and set the color temperature to 3200 K exactly by adjusting light.

Information on the Reflective Grayscale Chart (16:9) 

Recommended chart
The reflective grayscale chart (16:9) is commercially available.

• Product name: Reflective grayscale chart
• Supplier: MURAKAMI COLOR RESEARCH LABORATORY

Handling precautions
• Do not touch the chart’s surface with bare hands.
• Do not subject the surface to dirt or scratches.
• Do not prolonged exposure to sunlight.
• Protect the chart from excessive moisture or harmful gas.
• Avoid resting articles against the case.
• When the chart is not used for a long period and is stored, open the case and dry the chart for about an hour once

or twice a month.

Setting Illumination 
Measuring equipment : Illuminance meter (Calibrated)
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Procedure
1. Turn on the light source.
2. Warm up the light source for about 30 minutes.
3. Place the illuminance meter on the chart surface.
4. Adjust the position and angle of the light source so that the whole surface of the chart is evenly 2000 lx.

Note

Light the chart from almost the same direction and height as the camera to shoot the chart.

Chart

Illuminance meter Light source

Transparent grayscale chart (16:9)

Recommended chart
• Product name: Grayscale chart (16:9 transparent type)
• Sony Part No.: J-6394-080-A

Handling precautions
Use calibrated pattern box.

Setting Illumination
Measuring equipment : Illuminance meter
(KONICA MINOLTA LS-110 or equivalent , Calibrated)

Preparation
1. Place the pattern box where the chart is not exposed to light.

(Such as a darkroom, or cover the pattern box with a cover whose inside is painted in black.)
2. Light the pattern box.
3. Warm up the pattern box for about 30 minutes.

Procedure
1. Fix the luminance meter facing straight to the chart at a distance of 1 m from it.
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2. Adjust the luminance control of the pattern box so that the white portion in the center of the chart is 573 ±6 cd/m2.

Tip

This corresponds to the luminous intensity on the 89.9%-reflective chart at 2000 lx.

Chart

Luminance meter

1 m

5-1-4. Setup Menu

Camera equips setup menu. Some of adjustments given in this section use the setup menu without MSU.
In setup menu, operate from TOP MENU screen on the camera.
Configuration of TOP MENU screen is as follows.

• USER menu
• USER MENU CUSTOMIZE menu
• ALL menu
• OPERATION menu
• PAINT Menu
• MAINTENANCE Menu
• FILE Menu
• DIAGNOSIS menu
• SERVICE Menu

Note

For how to display the SERVICE menu, refer to “5-1-4-2. Displaying the SERVICE menu.”.

The setup menu operation is described as follows.
Example: When the AUTO SETUP page of MAINTENANCE menu is selected from the TOP menu and AUTO LEVEL
is performed.
MENU: MAINTENANCE
PAGE: AUTO SETUP
ITEM: AUTO LEVEL

Displaying TOP MENU screen

1. Turn the DISPLAY/MENU switch to the MENU side while pressing the MENU SEL knob/ENTER button.
[TOP] appears at the upper right of the screen of the monitor connected to SDI 1 connector.

2. Set the cursor at [TOP] and press the MENU SEL knob/ENTER button.
The TOP MENU screen showing the entire configuration of menu items appears.
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Displaying the SERVICE menu.

1. Display the MAINTENANCE menu.
2. Set the cursor at [AUTO SETUP] on MAINTENANCE menu and press the MENU SEL knob/ENTER button for

at least 10 seconds.
The cursor shifts to [AUTO BLACK].

3. Set the DISPLAY/MENU switch to OFF, and then turn the switch to the MENU side again.
The SERVICE menu is displayed.

Changing Setting Values

• Select a menu item by turning the MENU SEL knob/ENTER button and it is entered by pressing the MENU SEL
knob/ENTER button.

• For items whose values can be modified by turning the MENU SEL knob/ENTER button, set values can be entered
or suspended by the following operations.
To enter:
Press the MENU SEL knob/ENTER button.
To suspend:
Set the DISPLAY/MENU switch to OFF.
To restart the setting operation, turn the DISPLAY/MENU switch to the MENU side again.

Exiting menu

Set the DISPLAY/MENU switch to OFF.

5-1-5. Connection of Equipment

HDCU4300 connection example

CCA-5 cable
(max. 200 m)

Single-mode
fiber cables

(ST connectors, 1 pare)

Optical fiber
cable

CCU extension 
adapter
HKCU-SM100

SLOT1
(BNC x4)

Waveform monitor

Color monitor

Master setup unit
MSU-1000/1500

Camera control unit
HDCU4300

75 Ω

A-ch Y, Pb, Pr

R, G, B

HDC-P43
Lens
(for ENG/EFP)
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BPU4000/4500 connection example (extension mode)

CCA-5 cable
(max. 200 m)

Single-mode
fiber cables

(ST connectors, 1 pare)

Optical fiber
cable

CCU extension 
adapter
HKCU-SM100

SLOT1
(BNC x4)

Waveform monitor

Color monitor

Master setup unit
MSU-1000/1500

Camera extension
adapter HDCE-100

Baseband 
processor unit
BPU4000/4500

75 Ω

A-ch Y, Pb, Pr

R, G, B

HDC-P43
Lens
(for ENG/EFP)

Optical fiber
cable

5-1-6. Initial Settings

There are following Initial Settings.
• Set using the MSU.
• Set using setup menu and switches of the camera.

Before starting “5-2. Automatic Adjustment” or later, perform the initial setting.

When Adjusting with the MSU

Set each button on the MSU as follows.

• Power supply and signal switching block
- ALL button → OFF (unlit)
- CAM PW button → ON (lit)
- VF PW button → OFF (unlit)
- TEST 1 button → OFF (unlit)
- TEST 2 button → OFF (unlit)
- BARS button → OFF (unlit)
- CLOSE button → ON (lit)

• Camera/CCU circuit ON/OFF block
- KNEE OFF button → OFF (lit)
- DETAIL OFF button → OFF(lit)
- MATRIX OFF button → OFF (lit)
- AUTO KNEE button → OFF (lit)
- SKIN DETAIL button → OFF (lit)
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• Others
- GAMMA OFF button → ON (unlit)
- MASTER GAIN → 0 (0 dB)
- FILTER button (ND) → 1 (CLEAR)
- FILTER button (CC) → B (3200 K)
- ON button (shutter control block) → OFF (unlit)

When Adjusting with the Camera Setup Menu

Set each item and the switch, etc., as follows.
• PAINT Menu

Page Setting Item Initial Setting

SW STATUS FLARE ON

GAMMA ON

BLK GAM OFF

KNEE OFF

WHT CLIP OFF

DETAIL ON

LVL DEP ON

SKIN DTL OFF

MATRIX OFF

VIDEO LEVEL TEST OFF

KNEE AUTO KNEE OFF

SHUTTER SHUTTER OFF

OPTICAL FILTER ND 1 (CLEAR)

CC B (3200K)

• MAINTENANCE Menu

Page Setting Item Initial Setting

BLACK SHADING MASTER GAIN 0

5-1-7. Setup Menu Correspondence List

The camera setup menu items corresponding to the adjustment items of MSU are described.
Refer to the following tables when using the camera setup menu for electrical adjustments without using MSU.

PAINT Menu

• MSU:
[PAINT] button → ON (lit)

• Camera setup menu:
Select the [PAINT] men.
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Menu item of MSU Menu item of camera

Menu Sub Menu Adjustment Menu Page Item

Black  R/G/B PAINT VIDEO LEVEL BLACK [R/G/B/M]

Master

Flare  R/G/B FLARE [R/G/B/M]

Master

Detail 1/3 Level DETAIL 1 LEVEL

Limiter LIMITER [M]

Crispening CRISP

Level Dep LEVEL DEPEND

2/3 H/V Ratio DETAIL 2 H/V RATIO

3/3 W Limiter DETAIL 1 LIMITER [WHT]

B Limiter LIMITER [BLK]

Gamma Gamma R/G/B GAMMA LEVEL [R/G/B/M]

Master

Knee Knee Point R/G/B KNEE K POINT [R/G/B/M]

Master

Knee Slope R/G/B K SLOPE [R/G/B/M]

Master

White Clip  R/G/B WHITE CLIP —

Master W CLIP

FILE Menu

• MSU:
[FILE] button → ON (lit)

• Camera setup menu:
Select the [FILE] menu.

Menu item of MSU Menu item of camera

Menu Sub Menu Menu Page Item

Reference Reference Store FILE REFERENCE STORE FILE

Lens Lens Store LENS FILE STORE FILE

OHB OHB Store OHB FILE STORE FILE

MAINTENANCE Menu

• MSU:
[MAINTENANCE] button → ON (lit)

• Camera setup menu:
Select the [MAINTENANCE] menu.
Select the [PAINT] men.
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Menu item of MSU Menu item of camera

Menu Secondary
Menu

Sub Menu Adjust-
ment

Menu Page Item

Camera White Shading R/G/B H SAW MAINTENANCE WHITE
SHADING

H SAW [R/G/B]

H PARA H PARA [R/G/B]

V SAW V SAW [R/G/B]

V PARA V PARA [R/G/B]

Lens Auto Iris Settings Level AUTO IRIS IRIS LEVEL

APL Ratio APL RATIO

V Mod Saw R/G/B PAINT VIDEO LEV-
EL

V MOD [R/G/B/M]

Master
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5-2. Automatic Adjustment

5-2-1. Execute the Automatic Level Setup

1. Press the LEVEL button (AUTO SETUP block) on MSU.
LEVEL button lights. (ON)

2. Press the START/BREAK button (AUTO SETUP block) on MSU.
START/BREAK button lights (ON), automatic adjustment is executed.
After the adjustment is completed, the message “Completed” is displayed.

Tip

When performing automatic level setup using the camera setup menu, set as follows.
MENU: MAINTENANCE
PAGE: AUTO SETUP
ITEM: AUTO LEVEL
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5-3. Camera System Adjustment

5-3-1. Black Set Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500

Preparations

• Setting for the MSU
CLOSE button → ON (lit)
MASTER GAIN → 12 (12 dB)

Procedure

1. Operate the setup menu of MSU, and set the format to “4K/59.94P”.
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format] → “4096x2160/59.94P”

• When using the BPU4000/BPU4500
Touch panel operation: [BPU Multi Format] → [Shooting Transmit] → “4096x2160/59.94P”

2. Open following page by camera setup menu.
MENU: SERVICE
PAGE: BLACK SHADING

3. Adjust this using the waveform monitor so that the pedestal level of R channel becomes equal within a range of
–6 to +12 dB.
ITEM: BLK SET [R]

4. Also adjust G and B channels in the same way as above step.
ITEM: BLK SET [G]
ITEM: BLK SET [B]

5. Store the file.
MENU: SERVICE
PAGE: BLACK SHADING
ITEM: STORE FILE
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6. Make setting to the values adjusted in step 3 and step 4, store the file every following format.
Format
MSU:
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format]

- 4K/59.94P (2×): unsupported
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
• When using the BPU4000/BPU4500

Touch panel operation: [BPU Multi Format] → [Shooting Transmit]
- 4K/59.94P (2×):

→ “4096x2160/59.94P(x2)”
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
File store
MENU: SERVICE
PAGE: BLACK SHADING
ITEM: STORE FILE

5-3-2. Sensitivity Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Object: Grayscale chart

Preparations

• Setting for the MSU
CLOSE button → OFF (dark)
GAMMA OFF button → OFF (lit)
MASTER GAIN → 0 (0 dB)
DETAIL OFF button → OFF (lit)
Touch panel operation: (Page 1) → [Detail] → [1/3] → Level Dep OFF → OFF

• Confirm the amplitude of TEST SAW waveform.
1. Press the TEST 1 button of MSU to output TEST SAW waveform and to turn ON (lit).
2. Confirm that the amplitude is 700 mV using the waveform monitor.
3. If the amplitude is not 700 mV, confirm that R, G and B values are “0” by camera setup menu.

MENU: PAINT
PAGE: VIDEO LEVEL
ITEM: WHITE [R], [G], [B]

4. Press the TEST 1 button of MSU to stop TEST SAW waveform output and to turn OFF (unlit).
• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
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• Lens iris:
F8 (59.94P)

Procedure

1. Operate the setup menu of MSU, and set the format to “4K/59.94P”.
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format] → “4096x2160/59.94P”

• When using the BPU4000/BPU4500
Touch panel operation: [BPU Multi Format] → [Shooting Transmit] → “4096x2160/59.94P”

2. Set as follows by camera setup menu.
MENU: SERVICE
PAGE: OHB-ADJ1
ITEM: FILTER → OFF

3. Adjust the level of R channel, so that the level of portion A on the waveform becomes the specification.
ITEM: GAIN CONT [R1], [R2] (The values of [R1] and [R2] should be same.)
Specification: A = 700 mV (100%)

A

R G B

100%

A A

4. Also adjust G and B channels in the same way as above step.
ITEM: GAIN CONT [G1], [G2]
ITEM: GAIN CONT [B1], [B2]

5. Store the file.
MENU: SERVICE
PAGE: OHB-ADJ1
ITEM: STORE FILE

HDC-P43 5-13



6. Make setting to the values adjusted in above steps, store the file every following format.
Format
MSU:
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format]

- 4K/59.94P (2×): unsupported
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
• When using the BPU4000/BPU4500

Touch panel operation: [BPU Multi Format] → [Shooting Transmit]
- 4K/59.94P (2×):

→ “4096x2160/59.94P(x2)”
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
File Store
MENU: SERVICE
PAGE: OHB-ADJ1
ITEM: STORE FILE

5-3-3. Black Shading Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500

Preparations

• Setting for the MSU
CLOSE button → ON (lit)
GAMMA OFF button → OFF (lit)
MASTER GAIN → 12 (12 dB)
MASTER BLACK → 30 (30 dB)

Procedure

1. Operate the setup menu of MSU, and set the format to “4K/59.94P”.
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format] → “4096x2160/59.94P”

• When using the BPU4000/BPU4500
Touch panel operation: [BPU Multi Format] → [Shooting Transmit] → “4096x2160/59.94P”
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2. Open following page by camera setup menu.
MENU: SERVICE
PAGE: BLACK SHADING

3. Adjust this using the waveform monitor so that R channel waveform becomes as flat as possible.
ITEM: H SAW [R]
ITEM: H PARA [R]
ITEM: V SAW [R]
ITEM: V PARA [R]

(H SAW)
H: LINE

V: FIELD

(H PARA)

(V SAW) (V PARA)

4. Also adjust G and B channels in the same way as above step.
ITEM: H SAW [G], H PARA [G], V SAW [G], V PARA [G]
ITEM: H SAW [B], H PARA [B], V SAW [B], V PARA [B]

5. Store the file.
MENU: SERVICE
PAGE: BLACK SHADING
ITEM: STORE FILE
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6. Make setting to the values adjusted in step 3 and step 4, store the file every following format.
Format
MSU:
[CONFIG] button → ON (lit)

• When using the HDCU4300
Touch panel operation: [Multi Format] → [Base Format] → [4K/HFR Format]

- 4K/59.94P (2×): unsupported
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
• When using the BPU4000/BPU4500

Touch panel operation: [BPU Multi Format] → [Shooting Transmit]
- 4K/59.94P (2×):

→ “4096x2160/59.94P(x2)”
- HD/59.94P (2×):

→ “1920x1080/59.94P(x2)”
- HD/59.94P (4×):

→ “1920x1080/59.94P(x4)”
- HD/59.94P (8×):

→ “1920x1080/59.94P(x8)”
File store
MENU: SERVICE
PAGE: BLACK SHADING
ITEM: STORE FILE

5-3-4. White Shading Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Full-white pattern

Note

When the next condition corresponds to even one, white shading is not adjusted correctly.
• The brightness of the subject is uneven.
• The brightness is not set correctly.
• Iris value of lens is not set correctly.
• Zoom position is not set correctly.

Obey the contents of following preparation and procedure, use calibrated equipment and tools.

Preparations

• Setting for the MSU
KNEE OFF button → OFF (lit)
MASTER GAIN → 0 (0 dB)

• Shoot the full-white pattern so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
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• A = 600 ± 20 mV
If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

• Lens focus:: ∞
• Set the lens extender and shrinker as follows.

Lens extender (x2) → OFF
Lens shrinker (x0.8) → OFF

• Set as follows by camera setup menu.
MENU: FILE
PAGE: LENS FILE
1. Select the file in accordance with the lens attached. If there is no appropriate file, select “NO OFFSET”.
2. Change the name of lens with MSU.

Procedure

1. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Open the following items with using the MSU.
(1) MAINTENANCE button → ON (lit)
(2) Touch panel operation: [Camera] → [White Shading] → [R]

3. Adjust the waveform on the monitor so that the waveform levels out it as much as possible.
Adjustment item : H SAW
Adjustment item : H PARA
Adjustment item : V SAW
Adjustment item : V PARA

(H SAW)
H: LINE

V: FIELD

(H PARA)

(V SAW) (V PARA)

4. Make the same adjustment for channels G and B.
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5. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

OHB File Store

Store the OHB file in the MSU menu.

Procedure
1. [FILE] button → ON (lit)
2. Touch panel operation: [OHB] → [OHB Store] → [Store]

After the store operation is completed, the message “OHB File Store” is displayed.

Adjustment for Lens Extender or Shrinker

When the WHITE or shading of V is out of alignment by using the lens extender or shrinker, perform the following lens
adjustment after storing the OHB file

Procedure
1. Operate the control panel of MSU, and perform the automatic white balance adjustment.

WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Set the lens extender to ×1.
3. Operate the control panel of MSU, and store the lens file.

(1) [FILE] button → ON (lit)
(2) Touch panel operation: [Lens File] → [Lens Store] → [Store]

4. Set the lens extender and shrinker as follows.
• Lens extender (×2) → ON
• Lens shrinker (×0.8) → ON

5. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

6. Operate the control panel of MSU, and store the lens file.
(1) [FILE] button → ON (lit)
(2) Touch panel operation: [Lens File] → [Lens Store] → [Store]

7. Return the setting of lens extender and shrinker.
• Lens extender (x2) → OFF
• Lens shrinker (x0.8) → OFF
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5-4. Video System Level Adjustment

Note

Perform the video system level adjustment according to the system that the customer uses.

5-4-1. H/V Ratio Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Object: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)
KNEE OFF button → OFF (lit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
• A = 600 ±20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and set as follows.

Note

Customer’s settings must be restored after the adjustment. Write down the customer’s settings.

(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Detail] → [1/3]

Setting:
• Level → 99
• Limiter → 0
• Crispening → –25
• Level Dep → 25

2. Operate the [PAINT] menu of MSU, and set as follows.
Touch panel operation: (Page 1) → [Detail] → [2/3]
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3. Adjust the H/V Ratio adjustment, a ratio between H and V detail amounts (white) to be added shall be equal.
• Adjustment item : [H/V Ratio] (Reference value: 20 to 40)

H

V

4. Change the settings to the recorded customer’s settings.
5. Store the reference file.

(Refer to “5-4-12. File Store”.)

5-4-2. Detail Level Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Object: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)
KNEE OFF button → OFF (lit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
• A = 600 ±20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Detail] → [1/3]

2. Adjust the detail level to be added to each step of the grayscale to the desired level.
• Adjustment item: [Level]

3. Store the reference file.
(Refer to “5-4-12. File Store”.)
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5-4-3. Crispening Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Object: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
• A = 600 ± 20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Detail] → [1/3]
(3) Set adjustment item [Crispening] to “–99”.

3. Adjust the value of crispening.
• Adjustment item: [Crispening]

(1) Turn the adjustment knob of MSU to plus direction slowly.
(2) Stop the adjustment knob of MSU at the where the noise at the black level of the waveform just decreases.

4. Store the reference file.
(Refer to “5-4-12. File Store”.)

5-4-4. Level Dependent Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
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• Lens iris: F4 to F5.6
• A = 600 ±20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Detail] → [1/3]

Setting:
• Level Dep OFF → OFF

(3) Set adjustment item [Level Dep] to “–99”.
2. Adjust the level dependent.

• Adjustment item: [Level Dep]
(1) Turn the adjustment knob of MSU to plus direction slowly.
(2) Stop the adjustment knob of MSU at the where the edge of B portion on the waveform just decreases. Or

adjust for the desired level.

B

3. Store the reference file.
(Refer to “5-4-12. File Store”.)

Note

After adjustment is completed, be sure to perform “5-4-1. H/V Ratio Adjustment”.

5-4-5. Detail Clip Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)
KNEE OFF button → OFF (lit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
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• A = 600 ±20 mV
If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Make a line selection at the center white portion of the grayscale chart.

Line selection

3. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Detail] → [3/3]

4. Adjust the edge at portion B (white) to the desired clip level.
• Adjustment item: [W Limiter]

B

5. Adjust the edge at portion C (black) to the desired clip level.
• Adjustment item: [B Limiter]

C

6. Store the reference file.
(Refer to “5-4-12. File Store”.)
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5-4-6. Auto-iris Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparation

• Setting for the MSU
AUTO IRIS button → ON (lit)
DETAIL OFF button → ON (unlit)
KNEE OFF button → OFF (lit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.

Procedure

1. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Operate the control panel of MSU, and set as follows.
(1) MAINTENANCE button → ON (lit)
(2) Touch panel operation: [Lens] → [Auto Iris Settings]

3. To set the operation mode of auto-iris that is depending on a use, set the reaction degree of auto-iris.
(It can be set between the average and the peak value of video signal.)

• Adjustment item: [APL Ratio]
(–99: peak value to 99: average)

4. Adjust the convergence level of auto-iris so that the level of portion A on the waveform becomes the specification.
• Adjustment item: [Level]
• Specification: A = 700±7 mV

A

5. Store the reference file.
(Refer to “5-4-12. File Store”.)

5-4-7. Pedestal Level Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500

Preparation

• Setting for the MSU
CLOSE button → ON (lit)
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Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Black]

2. Adjust the levels A to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]
• Reference value: A = 21 mV

A

3. Store the reference file.
(Refer to “5-4-12. File Store”.)

5-4-8. Flare Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparation

• Setting for the MSU
DETAIL OFF button → ON (unlit)
KNEE OFF button → OFF (lit)
MATRIX OFF button → OFF (lit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
• A = 600 ±20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Flare]
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2. Adjust the levels B to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]

B

3. Store the reference file.
(Refer to “5-4-12. File Store”.)

5-4-9. Gamma Correction Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparation

• Setting for the MSU
KNEE OFF button → OFF (lit)
GAMMA OFF button → ON (unlit)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: A = 700 ±20 mV

A

Procedure

1. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.

2. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Gamma]
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3. Adjust the levels B to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]

B

4. Store the reference file.
(Refer to “5-4-12. File Store”.)

5-4-10. Knee Point and Knee Slope Adjustments

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500

Preparation

• Setting for the MSU
MASTER GAIN → 6 (6 dB)
TEST 1 button → ON (lit)
KNEE OFF button → ON (unlit)

Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 1) → [Knee] → [Knee Slope]
(3) Set adjustment item [Master] to “–99”.

2. Operate the control panel of MSU, and set as follows.
Touch panel operation: (Page 1) → [Knee] → [Knee Point]

3. Adjust the levels A to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]
• Reference value: A = 686 mV

A

4. Operate the control panel of MSU, and set as follows.
Touch panel operation: (Page 1) → [Knee] → [Knee Slope]
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5. Adjust the levels B to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]
• Reference value: B = 735 mV

B

6. Store the reference file.
(Refer to “5-4-12. File Store”.)

Setting after Adjustment

• Setting for the MSU
MASTER GAIN → 0 (0 dB)
TEST 1 button → OFF (unlit)
KNEE OFF button → OFF (lit)

5-4-11. White Clip Level Adjustment

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500

Preparation

• Setting for the MSU
MASTER GAIN → 12 (12 dB)
TEST 1 button → ON (lit)

Procedure

1. Operate the control panel of MSU, and set as follows.
(1) PAINT button → ON (lit)
(2) Touch panel operation: (Page 2) → [White Clip]

2. Adjust the levels A to desired level for R, G and B respectively.
To adjust all levels for R, G and B simultaneously, adjust them using [Master].

• Adjustment item : [R], [G], [B], [Master]
• Reference value: A = 756 mV

A

3. Store the reference file.
(Refer to “5-4-12. File Store”.)
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Setting after Adjustment

• Setting for the MSU
MASTER GAIN → 0 (0 dB)
TEST 1 button → OFF (unlit)

5-4-12. File Store

After adjustments described in “5-4. Video System Level Adjustment” are completed, be sure to store the reference file.

Reference File Store

Store the file in the MSU menu.

Procedure
1. FILE button → ON (lit)
2. Touch panel operation: [Ref File] → [Ref Store] → [Start]

After the reference file entry is completed, a message “Completed” is displayed.
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5-5. ND Offset Adjustment

5-5-1. White Balance Correction

Note

When the filter disk unit is replaced alone, the correction of white balance is required. Proceed as follows.

Equipment: Waveform monitor (R, G, B)
Test point: SLOT1 connectors (BNC x4) on the HDCU4300 or BPU4000/4500
Subject: Grayscale chart

Preparations

• Setting for the MSU
AUTO IRIS button → ON (lit)
MASTER GAIN → 0 (0 dB)

• Shoot the grayscale chart so that it is aligned with the under scanned monitor frame.
• Lens iris: F4 to F5.6
• A = 600 ±20 mV

If the lens aperture is greater than F5.6, adjust the light amount with the shutter.

A

Procedure

1. Set each button on the MSU as follows.
• FILTER CONTROL button → ON (lit)
• ND1 button → ON (lit)

2. Operate the control panel of MSU, and perform the automatic white balance adjustment.
WHITE button → ON (lit)
After the adjustment is completed, the message “AWB: OK” is displayed.
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3. Set the GAIN of ND filters 2 to 5 as follows. Perform the automatic white balance adjustment for each ND filter
using same procedure.

• ND filter 2
ND2 button → ON (lit)
MASTER GAIN → 0 (0 dB)

• ND filter 3
ND3 button → ON (lit)
MASTER GAIN → 0 (0 dB)

• ND filter 4
ND4 button → ON (lit)
MASTER GAIN → 6 (6 dB)

• ND filter 5
ND5 button → ON (lit)
MASTER GAIN → 12 (12 dB)

Note

Change GAIN values because the iris open end is not used.

OHB File Store

Store the OHB file in the MSU menu.

Procedure
1. [FILE] button → ON (lit)
2. Touch panel operation: [OHB] → [OHB Store] → [Store]

After the store operation is completed, the message “OHB File Store” is displayed.

Setting after Adjustment

• Setting for the MSU
MASTER GAIN → 0 (0 dB)
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5-6. RPN Compensation

• To compensate the RPN, age the camera for more than 30 minutes.
• When executing the automatic compensation (APR) from MSU or setting menu, the residual point noise (RPN)

of the CMOS image sensor is compensated.
• To compensate the RPN, compensate according to the following chart.

5-6-1. Automatic 
Compensation (APR)

Is RPN disappeared?

Compensation 
starting

Yes

No

Compensation OK

Is RPN disappeared?
Yes

No

Compensation OK

Compensation OK

5-6-2. Manual RPN
Compensation adjustment

5-6-3. Procedures to be 
Taken when the RPN 
Compensation Fails

5-6-1. Automatic Compensation (APR)

When an RPN is detected in the screen, perform the automatic compensation (APR).

Automatic RPN Compensation (APR)

Note

• RPN automatic compensation should be performed both HD and 4K.
• Manual RPN compensation adjustment data is not affected by executing the automatic RPN compensation (APR).
• Automatic RPN compensation (APR) take several minutes.

Preparations
• Lens iris → CLOSE

Or remove the lens and attach the lens mount cap to the lens mount.
• Setting for the MSU

BARS button → OFF (dark)
SHUTTER button → OFF (dark)
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Procedure
1. Execute automatic RPN compensation (APR) from MSU or camera.

• Execute automatic RPN compensation (APR) from MSU.
[MAINTENANCE] button → ON (lit)
Touch panel operation: [Auto Setup] → [APR]

Note

Confirm that the operation of the Auto Setup menu is enabled in the Item Permission of the MSU. (Refer to
Operation manual of MSU.)

• Execute automatic black balance adjustment (ABB) from camera to automatic RPN compensation (APR).
MENU: SERVICE
PAGE: RPN MANAGE
ITEM: AUTO CONCEAL

Note

The history information of the address data of detected RPN is updated each time APR is performed. If no RPN
is detected in consecutive five APRs, RPN is excluded from the correction target (by deleting data).

5-6-2. Manual RPN Compensation Adjustment

When RPN is not compensated after RPN automatic compensation was performed, execute the manual RPN
compensation adjustment.

Preparation

1. Execute RPN automatic compensation(APR).
(Refer to “5-6-1. Automatic Compensation (APR)”.)

Procedure

1. Open following page by camera setup menu.
MENU: SERVICE
PAGE: MANUAL RPN

<MANUAL RPN>         S03 TOP

 RPN CH SELECT   :     R
 RPN CURSOR      :   OFF
 CURSOR H POS.   :  1006
 CURSOR V POS.   :   575
 CURSOR JUMP     :  CURR
 RECORD RPN      :  EXEC
 DELETE RPN      :  EXEC

2. Select the channel (R, G, or B) that is to be compensated.
ITEM: RPN CH SELECT → R, G, B

3. Display the cross cursor.
ITEM: RPN CURSOR → ON

4. Set the cross cursor center at the target RPN.
ITEM: CURSOR H POS.
ITEM: CURSOR V POS.
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5. Execute record of RPN compensation adjustment data.
ITEM: RECORD RPN → EXEC
A message “RECORD DATA OK? YES → NO” is displayed.

Note

In the case of RPN is disappeared in the screen, perform step 6.
In the case of RPN is appeared in the screen, the cross cursor may not move to the position of RPN. Perform
procedures as follows.
(1) Select (turn the knob) “NO” by rotary encoder and confirm (press the button).
(2) Shift the center of cross cursor by one line or one pixel and move to position of RPN.
(3) Perform step 5.

6. Select (turn the knob) “YES” by rotary encoder and confirm (press the button).
A message “COMPLETE” is displayed, the compensation data is recorded.

Tip

If a compensation pixel has been wrongly recorded, delete the RPN data.
ITEM: DELETE RPN → EXEC

7. Repeat steps 4 to 6 to compensate other RPNs.

Tip

If adjust using the MSU, enter the engineer mode and operate in the following page. (Refer to Operation manual of
MSU.)
[MAINTENANCE] button → ON (lit)
Touch panel operation: [RPN]

Setting after adjustment

1. Hide the cross cursor.
ITEM: RPN CURSOR → OFF

5-6-3. Procedures to be Taken when the RPN Compensation Fails

When the RPN compensation is not successful even after the manual RPN compensation adjustment was made, the
following causes are possible.

• An adjacent wrong position was compensated.
• The compensation failed due to the influence of other RPNs.

Note

Appearance of an RPN next to the pixel to be compensated means that adjacent RPNs exit. If an RPN appears in the
diagonal direction, the RPN cannot be compensated. In this case, the CMOS image sensors or the OHB assembly must
be replaced.
For more information, contact your local Sony Sales Office/Service Center.
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Procedure

1. Open following page by camera setup menu.
MENU: SERVICE
PAGE: MANUAL RPN

<MANUAL RPN>         S03 TOP

 RPN CH SELECT   :     R
 RPN CURSOR      :   OFF
 CURSOR H POS.   :  1006
 CURSOR V POS.   :   575
 CURSOR JUMP     :  CURR
 RECORD RPN      :  EXEC
 DELETE RPN      :  EXEC

2. Display the cross cursor.
ITEM: RPN CURSOR → ON

3. Check whether there are any compensated pixels close to the pixel to be compensated.
• When the target pixel is above the cursor position,

ITEM: CURSOR JUMP → PREV
• When the target pixel is under the cursor position,

ITEM: CURSOR JUMP → NEXT

Tip

To compensate effectively RPN, perform as follows.
• After placing the cursor in advance close to the pixel to be compensated by using CURSOR H POS. and

CURSOR V POS, execute the CURSOR JUMP function.

4. When the cursor stopped at a position near the target pixel, Delete the compensation data at stop position of cursor.
(1) Delete the compensation data.

ITEM: DELETE RPN → EXEC
A message “DELETE DATA OK? YES → NO” appears.

(2) Select (turn the knob) “YES” by rotary encoder and confirm (press the button).
5. When the cursor is not moved by executing the CURSOR JUMP, move the cursor in the direction of horizontal or

vertical, and execute it again.
ITEM: CURSOR H POS.
ITEM: CURSOR V POS.

6. Record the RPN compensation adjustment data.
ITEM: RECORD RPN → EXEC
A message “RECORD DATA OK? YES → NO” is displayed.

7. After confirming that RPN disappears, select (turn the knob) “YES” by rotary encoder and confirm (press the
button).
A message “COMPLETE” is displayed, the compensation data is recorded.
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Section 6
Software Upgrade

6-1. Upgrading Software Programs

Software programs stored in the ROM (IC401) on the AT-189V board is upgraded by using a USB drive.
The software programs include camera application and operating system (OS), which is independently upgraded.
Use the following procedures to upgrade the software programs.

6-1-1. Upgrading Camera Application

Equipment Required

• USB drive (commercially available)

Tip

For recommended USB drive, refer to “Using a USB Drive” on the operation manual.

Preparations

Copy the camera application update data to the USB drive using the following procedure.

Note

For how to obtain the data file for update (hdcp43_app.pkg), contact your local Sony Sales Office/Service Center.

1. Create the following directory in the USB drive.
\MSSONY\PRO\CAMERA\HDCP43

2. Copy the data file for update “hdcp43_app.pkg” to the directory created.

Procedure

1. Connect the USB drive that contains the program for update to the USB connector of this unit.
2. Turn on the power of the unit.
3. Display the ROM VERSION page of the DIAGNOSIS menu.
4. Confirm that the cursor “?” is displayed to the left of page number, and then press the MENU SEL knob/ENTER

button long.
5. Updatable items become selectable. Select “CAMERA APP” and then press the MENU SEL knob/ENTER button.
6. A message “VERSION UP OK?” appears. Select “YES”.

The unit restarts automatically and the version update starts.
Upon completion of the version update, a message “UPDATE SUCCEEDED” appears.

7. Turn off and on the power of the unit and confirm that the version has been updated on the ROM VERSION page
of the DIAGNOSIS menu.

6-1-2. Upgrading OS

Equipment Required

• USB drive (commercially available)

Tip

For recommended USB drive, refer to “Using a USB Drive” on the operation manual.
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Preparations

Copy the OS update data to the USB drive using the following procedure.

Note

For how to obtain the data file for update (hdcp43_os.pkg), contact your local Sony Sales Office/Service Center.

1. Create the following directory in the USB drive.
\MSSONY\PRO\CAMERA\HDCP43

2. Copy the data file for update “hdcp43_os.pkg” to the directory created.

Procedure

1. Connect the USB drive that contains the program for update to the USB connector of this unit.
2. Turn on the power of the unit.
3. Display the ROM VERSION page of the DIAGNOSIS menu.
4. Confirm that the cursor “?” is displayed to the left of page number, and then press the MENU SEL knob/ENTER

button long.
5. Updatable items become selectable. Select “OS” and then press the MENU SEL knob/ENTER button.
6. A message “VERSION UP OK?” appears. Select “YES”.

The unit restarts automatically and the version update starts.
Upon completion of the version update, a message “UPDATE SUCCEEDED” appears.

7. Turn off and on the power of the unit and confirm that the version has been updated on the ROM VERSION page
of the DIAGNOSIS menu.
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6-2. PLD

This unit uses the PLD (Programmable Logic Device) that supports USB drive to write and rewrite the internal data.
If the part listed below needs to be replaced or to be upgraded, contact your local Sony Sales Office/Service Center.

Note

The part number of PLD (or ROM for PLD) in which data is not written yet, is shown in “Spare Parts”.
Therefore, if part replacement is required, write the data by the following procedure.
In the case of the PLD type that runs on the program stored in external ROM, data needs not to be written only by
replacing the part if the specific PLD only is defective.

6-2-1. Corresponding PLD

Item File Board Ref. No.

DPR hdcp43_dpr.pkg DPR-376 IC1001
IC1303 (Config ROM)

SY hdcp43_sy.pkg SY-449 IC701
IC804 (Config ROM)

6-2-2. Upgrading PLD Data

Equipment Required

• USB drive (commercially available)

Tip

For recommended USB drive, refer to “Using a USB Drive” on the operation manual.

Preparations

Copy the PLD update data to the USB drive using the following procedure.

Note

For how to obtain the data file for update (hdcp43_dpr.pkg, hdcp43_sy.pkg), contact your local Sony Sales Office/Service
Center.

1. Create the following directory in the USB drive.
\MSSONY\PRO\CAMERA\HDCP43

2. Copy the data files for PLD update to be updated to the directory created.

Procedure

1. Connect the USB drive that contains the program for update to the USB connector of this unit.
2. Turn on the power of the unit.
3. Display the ROM VERSION page of the DIAGNOSIS menu.
4. Confirm that the cursor “?” is displayed to the left of page number, and then press the MENU SEL knob/ENTER

button long.
5. Updatable items become selectable. Select the PLD to be upgraded and then press the MENU SEL knob/ENTER

button.
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6. A message “VERSION UP OK?” appears. Select “YES”.
The unit restarts automatically and the version update starts.
Upon completion of the version update, a message “UPDATE SUCCEEDED” appears.

7. Turn off and on the power of the unit and confirm that the version has been updated on the ROM VERSION page
of the DIAGNOSIS menu.
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6-3. Forced Version Update

If the version of program or data cannot be updated from the ROM VERSION page of the DIAGNOSIS menu, the
software or PLD data version can be updated by the “forced version update.”

6-3-1. Forced Version Upgrade of Software or PLD Data

Equipment Required

• USB drive (commercially available)

Tip

For recommended USB drive, refer to “Using a USB Drive” on the operation manual.

Preparations

Copy the software or PLD data version update data file to the USB drive using the following procedure.

Note

For how to obtain the data files for update, contact your local Sony Sales Office/Service Center.

1. Create the following directory in the USB drive.
\MSSONY\PRO\CAMERA\HDCP43

2. Copy the data file for update to be updated to the directory created.

Note

Do not copy software or PLD data that is not to be updated.

Procedure

1. Connect the USB drive that contains the program for update to the USB connector of this unit.
2. While press the MENU SEL knob/ENTER button on the unit and the VTR button on the lens, turn on the power

of the unit.
Each data file for update copied in the USB drive is updated.
Upon completion of the version update, a message “UPDATE SUCCEEDED” appears.

Tip

The version update progress status is displayed on the a monitor connected to the SDI 1 connector.

3. Turn off and on the power of the unit and confirm that the version has been updated on the ROM VERSION page
of the DIAGNOSIS menu.
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Section 7
File System

This unit is equipped with the file systems for managing data.

In this section, the menu operations are described as follows.
Example: When executing WRITE (CAM → USB) on the OPERATOR FILE page of the OPERATION menu
[OPERATION] → [OPERATOR FILE] → [WRITE (CAM → USB)]
As for the details on the setup menu, refer to “8. Setup Menu”.

7-1. File Structure

The following six types of files are available. As for the items to be stored in each file, refer to “7-8. File Items”.
1. Operator File (Refer to “7-2. Operator File”.)

Stores the items displayed on the viewfinder and switch settings for camera operator.
This file can be stored in a USB drive, yet video data (paint data) cannot be stored.

Tip

When any PAINT menu item is added to USER menu on USER MENU CUSTOMIZE menu, corresponding paint
data is stored in the operator file.

2. Preset Operator File (Refer to “7-3. Preset Operator File”.)
Stores the factory settings of Operator File.
This file can be stored in the camera, yet video data (paint data) cannot be stored.

3. Scene File (Refer to “7-4. Scene File”.)
Stores the temporary video setting data according to the scene.
This file can be stored in the camera and a USB drive.

4. Reference File (Refer to “7-5. Reference File”.)
Stores the custom paint data adjusted by the video engineer.
This file can be stored in the camera and a USB drive.

5. Lens File (Refer to “7-6. Lens File”.)
Used for compensation of the deviation which is generated by switching the lens extender from OFF to ON and
for compensation of the difference in the characteristics between lenses.
This file is stored in the camera.

6. OHB File (Refer to “7-7. OHB File”.)
Used for adjustment of the prism block maintenance.
This file is stored in the camera.
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7-1-1. Structure of Paint Related Files

When STANDARD
is executed. 

Factory-set value 0

Output to
hardware (*1)

Scene File
Refer to “File Item” (*2)

Refer to “File Item” (*2)

Lens File
• The following items can be stored, when lens extender setting is OFF:
 - Flare R/G/B
 - V Modulation Shading R/G/B/Master
 - Auto Iris Gain
• The following items can be stored, when lens extender setting is ON:
 - White R/B
 - Flare R/G/B
 - V Modulation Shading R/G/B/Master
 - Auto Iris Gain

OHB File
• The following items can be stored of black shading:
 - R/G/B for H  SAW, H  PARA, V SAW, V  PARA
• The following items can be stored of white shading
 - R/G/B for H  SAW, H  PARA, V SAW, V  PARA
• ND offset
• OHB matrix

Reference File

(*1): The additional data of each file is sent to each circuit in the unit.
(*2): For items that can be stored in the scene file and the reference file, refer to “7-8. File Items”.
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7-2. Operator File

The operator file can be stored and read in the camera.
Use the setup menu to store the operator file in and read the operator file from the USB drive.

Note

• Operator file data stored in the USB drive cannot be read when the power is just turned ON.
• The current operator file data is retained even when the power is turned off.

7-2-1. Operator File Operation

Outline Figure of Operation

Current Operator
File Data

Output to hardware

USB drive

Camera unit

Storing
(Step 1)

Reading
(Step 2)

Preset Operator
File

Preset Operator File
Factory-set
value

Storing

Reference: Refer to step 1 of 7-2-1.“Outline Figure of Operation”.

Using OPERATION menu of this unit
1. Stores the current status in the USB drive.

[OPERATION] → [OPERATOR FILE] → [WRITE (CAM → USB)]

Reading

Reference: Refer to step 2 of 7-2-1.“Outline Figure of Operation”.

Using OPERATION menu of this unit
1. Reads the operator file stored in the USB drive to the camera.

[OPERATION] → [OPERATOR FILE] → [READ (USB → CAM)]
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7-3. Preset Operator File

Preset operator file data can be stored in the camera.
Data is called and stored using the setup menu. Items to be stored as preset operator file are the same as operator file.

7-3-1. Preset Operator File Operation

Outline Figure of Operation

Current Operator
File Data

Output to hardware

USB drive

Camera unit

Preset Operator
File

Preset Operator File
Factory-set
value

Calling
(Step 1) Initializing

(Step 3)

Storing
(Step 2)

Calling

Reference: Refer to step 1 of 7-3-1.“Outline Figure of Operation”.

Using OPERATION menu of this unit
1. Loads the preset operator file stored in the camera as the current operator file.

[OPERATION] → [OPERATOR FILE] → [PRESET]

Storing

Reference: Refer to step 2 of 7-3-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Stores the current operator file as the preset operator file.

[FILE] → [OPERATOR FILE] → [STORE PRESET FILE]

Initializing

Reference: Refer to step 3 of 7-3-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Introduce preset operator file from the factory settings.

[FILE] → [FILE CLEAR] → [PRESET OPERATOR]
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7-4. Scene File

Scene files can be stored in the camera and USB drive.
Scene files can also be stored in the memory stick if the master setup unit (here after MSU) is used. For details, refer to
the MSU operation manual.
Data is stored and called using the setup menu or MSU.
Scene files can be copied between cameras using the USB drive.

Note

• Scene Files are files for storing the differences from the Reference File. Therefore, when the Reference File is
changed, output of the Scene File item corresponding to the item changed in the Reference File also varies.

• Scene File data stored in the USB drive cannot be read when the power is just turned on.

7-4-1. Scene File Operation

Outline Figure of Operation

Current paint data

Output to hardware

Camera unit

USB driveScene File

Storing
(Step 1)

Calling
(Step 2)

Storing in
USB drive
(Step 3)

Reading from
USB drive
(Step 4)

Storing

Reference: Refer to step 1 of 7-4-1.“Outline Figure of Operation”.

Using PAINT menu of this unit
1. Change the scene file item to the desired value.
2. Select the scene file number [1] to [5] to be stored.

[PAINT] →[SCENE FILE] → [STORE] → [1] to [5]

With MSU
1. Change the scene file item to the desired value.
2. Press the STORE button in the functional operation area on the operation panel.
3. Press the scene file number button in the functional operation area on the operation panel.

Calling and Clearing the Call

Reference: Refer to step 2 of 7-4-1.“Outline Figure of Operation”.

Using PAINT menu of this unit
1. Select the scene file number to be called.

[PAINT] →[SCENE FILE] → [1] to [5]
A file currently being called is indicated with its file number highlighted.
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2. Select the number again.
Calling the scene file is canceled and it is resumed in the previous status.

With MSU
1. Press the number button of the scene file you want to call while the STORE button on the operation panel is not

lit to lit button.
The scene file of the number is called.

2. Repress the number button.
Calling the scene file is canceled and it is resumed in the previous status.

Storing the Scene File to the USB Drive

Reference: Refer to step 3 of 7-4-1.“Outline Figure of Operation”.

Using PAINT menu of this unit
1. Stores the scene file stored in the camera to the USB drive.

[PAINT] →[SCENE FILE] → [WRITE (CAM →USB)]

Reading the Scene File from the USB Drive

Reference: Refer to step 4 of 7-4-1.“Outline Figure of Operation”.

Using PAINT menu of this unit
1. Reads the scene file stored in the USB drive to the camera.

[PAINT] →[SCENE FILE] → [READ (USB → CAM)]

Note

Scene File data stored in the USB drive cannot be read when the power is just turned on.
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7-5. Reference File

Reference files can be stored in the camera and USB drive.
Scene files can also be stored in the memory stick if the master setup unit (here after MSU) is used. For details, refer to
the MSU operation manual.
Data is stored and called using the setup menu or MSU.
Reference files can be copied between cameras using the USB drive.

Note

• Reference File stores the differential data taking the factory-setting as 0. Therefore, initializing the Reference File
brings the settings to the same status at the factory setting. If Lens File or OHB File retains the data, they need to
be initialized as well.
To initialize data, use the setup menu. You can select all file items or only specified items to initialize.

• Reference File data stored in the USB drive cannot be read when the power is just turned on.

7-5-1. Reference File Operation

Outline Figure of Operation

Current paint data

Output to hardware

Camera unit

USB drive

Reference File
Reference File
factory-set value
(Initial value 0)

Storing in
USB drive
(Step 4)

Reading from
USB drive
(Step 3)

Initializing
(Step 5)

Calling
(Step 2)

Storing
(Step 1)

Storing

Reference: Refer to step 1 of 7-5-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Store the current status of the reference file.

[FILE] → [REFERENCE] → [STORE FILE]
Reference file data is stored in the camera and numerical data is indicated as 0.
(Except for some data. Refer to “7-8. File Items”.)

With MSU
1. Press the FILE button in the menu operational area on the operation panel.
2. Select [Reference] → [Reference Store] by the menu operation.

Reference file data is stored in the camera and numerical data is indicated as 0.
(Except for some data. Refer to “7-8. File Items”.)
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Calling

Reference: Refer to step 2 of 7-5-1.“Outline Figure of Operation”. Refer to “7-1-1. Structure of Paint Related Files”.

Using PAINT menu of this unit
1. Restore the data at the time when the reference file is stored.

[PAINT] →[SCENE FILE] → [STANDARD]
Temporary paint (values of each item) and selection of scene file are reset, and the state when the reference file
was stored is resumed.

With MSU
1. Pressing the STANDARD button in the camera/panel control area on the operation panel.

Reference file is restored at the time when it was stored.

Reading the Reference File from the USB Drive

Reference: Refer to step 3 of 7-5-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Reads the reference file stored in the USB drive to the camera.

[FILE] → [REFERENCE] → [READ (USB → CAM)]

Note

Reference File data stored in the USB drive cannot be read when the power is just turned on.

Storing the Reference File in the USB Drive

Reference: Refer to step 4 of 7-5-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Stores the reference file stored in the camera to the USB drive.

[FILE] → [REFERENCE] → [WRITE (CAM → USB)]

Initializing All File Items

Reference: Refer to step 5 of 7-5-1.“Outline Figure of Operation”.

Using FILE menu of this unit
1. Re-set the reference file to the factory settings (default value: 0).

[FILE] → [FILE CLEAR] → [REFERENCE (ALL)]
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7-6. Lens File

The Lens File stores the differential data from the Reference File.
The lens file is stored white shading generated when the extender is turned on, flare balance, white balance, F value at
the lens open end, lens name, and other data. These adjustment data are stored in the camera.
Lens File data of up to 16 files can be stored for a lens that is not compatible with serial communication.
The adjustment data can be called by selecting a Lens File.

Note

Before creating the Lens File, perform the necessary adjustments by using the lens usually used and register the Reference
File.

7-6-1. Lens File Operation

Adjusting Lens and Setting Lens File

For lens non-compatible with serial communication
1. Attach a lens and select a file with the same name as the lens name from the setup menu.

[FILE] → [LENS FILE] → Select a lens number.
If there is no file with the same name as the lens name, select “NO OFFSET.”

2. Set the lens name and the F value at the lens open end.
[FILE] → [LENS FILE] → [NAME] , [F NO]

3. Turn OFF the lens extender.
4. Shoot the white pattern, and fine-adjust it with V modulation R/G/B/Master so that the video level is around 80%

(560 mV) with the lens iris set around F4 and the zoom control in the center of the ring.
[PAINT] → [VIDEO LEVEL] → [V MOD] → [R/G/B/M]

5. Adjust the white balance and flare balance with the grayscale chart.
(1) White balance adjustment

[MAINTENANCE] → [AUTO SETUP] → [AUTO WHITE]
(2) Flare Balance Adjustment

[PAINT] → [VIDEO LEVEL] → [FLARE] → [R/G/B/M]
6. Display a center marker.

[OPERATION] → [VF MARKER] → [CENTER] → Set to “ON”.
7. Move the lens zoom to set the center marker at a position where the subject does not move.

[FILE] → [LENS FILE] → [CENTER MARKER] → [H POS] , [V POS] , [STORE]

Note

The center marker position is stored in the Lens File immediately after the position is aligned. Note that the center
marker position is not stored when Lens File Store is executed.

8. Writing data to lens file.
[FILE] → [LENS FILE] → [STORE FILE]

9. Turn ON the lens extender and repeat steps 4 to 8.

For lens compatible with serial communication
1. Confirm that the lens number is 17.

[FILE] → [LENS FILE] → Confirm lens number 17.
2. Check the automatically set lens name and the F value at the lens open end.

[FILE] → [LENS FILE] → [NAME] , [F NO]
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3. Check the shading.

Note

Only when deviation is generated, adjust the white shading or V modulation. In this case, no data is stored in the
lens file.

• White Shading Adjustment
Shoot a full-white pattern so that the video level becomes approx. 80 % (560 mV), and then perform the
automatic white shading adjustment or adjust white shading V SAW, V PARA, H SAW, and H PARA for R,
G, and B.

- Automatic white shading adjustment
[MAINTENANCE] → [WHITE SHADING] → [AUTO WHITE SHADING]

- White shading correction
[MAINTENANCE] → [WHITE SHADING] → [V SAW] , [V PARA] , [H SAW] , [H PARA] →
[R/G/B]

• V Modulation Adjustment
Shoot the white pattern, and fine-adjust it with V modulation R/G/B/Master so that the video level is around
80% (560 mV) with the lens iris set around F4 and the zoom control in the center of the ring.
[PAINT] → [VIDEO LEVEL] → [V MOD] → [R/G/B/M]

4. Turn OFF the lens extender.
5. Adjust the white balance and flare balance with the grayscale chart.

(1) White balance adjustment
[MAINTENANCE] → [AUTO SETUP] → [AUTO WHITE]

(2) Flare Balance Adjustment
[PAINT] → [VIDEO LEVEL] → [FLARE] → [R/G/B/M]

6. Display a center marker.
[OPERATION] → [VF MARKER] → [CENTER] → Set to “ON”.

7. Move the lens zoom to set the center marker at a position where the subject does not move.
[FILE] → [LENS FILE] → [CENTER MARKER] → [H POS] , [V POS] , [STORE]

Note

The center marker is not stored by the lens file store, but is stored immediately after adjustment. Note that if the
center marker is changed, it is stored in the lens file even in the normal use.

8. Move the lens zoom to compensate F drop.
[MAINTENANCE] → [LENS] → [F DROP COMP] → [ROUNDNESS] , [MAX GAIN] , [DROP POINT]
(1) Set the [F DROP COMP] to “ON” and set the [ROUNDNESS] to “0 dB”.
(2) Adjust the [MAX GAIN] so that the level of TELE end at the time of iris opening becomes same as level of

WIDE end.
(3) Adjust the [DROP POINT] so that the level at the time of controlling the zoom slightly to WIDE end from

TELE end becomes same as level of TELE end.
(4) Detect the position of lowest level between TELE end and WIDE end by controlling the zoom, and adjust

the [ROUNDNESS] so that the level of the position becomes same as level of WIDE end and TELE end.
9. Writing data to lens file.

[FILE] → [LENS FILE] → [STORE FILE]
10. Turn ON the lens extender and repeat steps 5 to 8.

Calling

Using OPERATION menu of this unit
Loads the lens file stored in the camera.
1. Select the set lens file.

[FILE] → [LENS FILE] → Select a lens number.
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7-7. OHB File

OHB file is used to store the adjustment values specific to the prism block.
OHB file data is stored in the camera.
OHB file data can be adjusted and stored by using the setup menu or the master setup unit (here after MSU).

Note

Store the OHB file after all items have been adjusted. Before adjusting and storing only specific items, be sure to execute
STANDARD in Step 1 below.

7-7-1. OHB File Operation

Adjusting and Storing

Using FILE and MAINTENANCE Menu of This Unit
1. Loads the reference file stored in the camera.

[FILE] → [REFERENCE] → [STANDARD]
2. Adjust the black shading V SAW, V PARA, H SAW, and H PARA for R, G and B.

[MAINTENANCE] → [BLACK SHADING] → [V SAW] , [V PARA] , [H SAW] , [H PARA] → [R/G/B]
3. Perform the automatic black balance adjustment.

[MAINTENANCE] → [AUTO SETUP] → [AUTO BLACK]
4. Shoot a full-white pattern so that the video level becomes approx. 80 % (560 mV).
5. Repeat the automatic white shading adjustment 3 times or more.

[MAINTENANCE] → [WHITE SHADING] → [AUTO WHITE SHADING]
(1) When adjustment is not completed correctly, adjust the white shading V SAW, V PARA, H SAW, and H PARA

for R, G and B.
[MAINTENANCE] → [WHITE SHADING] → [V SAW] , [V PARA] , [H SAW] , [H PARA] → [R/G/B]

6. Adjust the ND offset.

Note

• Adjust the ND offset for all of ND filter 1 to ND filter 5.

(1) Select the ND filter 5, and shoot a full-white pattern so that the video level becomes approx. 50 % (350 mV).
(2) Select the ND filter 1, and adjust the lens iris so that the video level becomes approx. 80 to 50 % (560 to 350

mV)
(3) Perform the automatic white balance adjustment.

[MAINTENANCE] → [AUTO SETUP] → [AUTO WHITE]
(4) Select the ND filter 2, and adjust in the same procedures as step (2) to (3).
(5) Select the ND filter 3, and adjust in the same procedures as step (2) to (3).
(6) Select the ND filter 4, and adjust in the same procedures as step (2) to (3).
(7) Select the ND filter 5, and adjust in the same procedures as step (2) to (3).

7. Store the OHB File.
[FILE] → [OHB FILE] → [STORE FILE]

With MSU
1. Pressing the STANDARD button in the camera/panel control area on the operation panel. (ON: lit)
2. Press the FILE button in the menu operational area on the operation panel. (ON: lit)
3. Adjust the black shading V SAW, V PARA, H SAW, and H PARA for R, G and B.

[OHB] → [Adjusting] → [Black Shading] → [R/G/B] → [V SAW] , [V PARA] , [H SAW] , [H PARA]
4. Perform the automatic black balance adjustment.

Pressing the BLACK button in the camera/panel control area on the operation panel. (ON: lit)
Or select [OHB] → [Auto Black] by the menu operation.

5. Shoot a full-white pattern so that the video level becomes approx. 80 % (560 mV).
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6. Repeat the automatic white shading adjustment 3 times or more.
[OHB] → [Auto W Shading]
(1) When adjustment is not completed correctly, adjust the white shading V SAW, V PARA, H SAW, and H PARA

for R, G and B.
[OHB] → [Adjusting] → [White Shading] → [R/G/B] → [V SAW] , [V PARA] , [H SAW] , [H PARA]

7. Adjust the ND offset.

Note

• Adjust the ND offset for all of ND filter 1 to ND filter 5.

(1) Select the ND filter 5, and shoot a full-white pattern so that the video level becomes approx. 50 % (350 mV).
(2) Select the ND filter 1, and adjust the lens iris so that the video level becomes approx. 80 to 50 % (560 to 350

mV)
(3) Select the ND filter 2, and adjust in the same procedures as step (2) to (3).
(4) Select the ND filter 3, and adjust in the same procedures as step (2) to (3).
(5) Select the ND filter 4, and adjust in the same procedures as step (2) to (3).
(6) Select the ND filter 5, and adjust in the same procedures as step (2) to (3).

8. Store the OHB File.
[OHB] → [OHB Store] → [Store]
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7-8. File Items

Data that is set by the setup menu can be stored in a file.
This section lists files in which each piece of set data is to be stored on a function basis.

Description on symbols
• ○: Shows that the item is stored in the file when the file store menu for the file is performed.

(However, ON (OFF) means that the item is set to ON (OFF) in the file.)
• ×: Shows that the item is not stored in the file.
• —: Shows that the item is not stored in the file by temporary operation, etc.

Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

GAIN Master Gain
Select*1

 ○ ○ × × ×

Iris  IRIS × × × × ×

Auto Iris on  ○ ○ × × ×

 Level ○ ○ × × ×

 APL ○ ○ × × ×

 Gain ○ ○ ○ × ×

 Over ride × × × × ×

Detect Pattern  ○ ○ ○ × ×

Close  × OFF × × ×

Shutter Shutter ON  ○ OFF × × ×

Shutter Select  ○ × × × ×

ECS ECS ON  ○ OFF × × ×

 ECS Frequency ○ × × × ×

Black Shading  Black Shading H
Saw-R

× × × × ○

  Black Shading H
Saw-G

× × × × ○

  Black Shading H
Saw-B

× × × × ○

  Black Shading V
Saw-R

× × × × ○

  Black Shading V
Saw-G

× × × × ○

  Black Shading V
Saw-B

× × × × ○

  Black Shading H
Para-R

× × × × ○

  Black Shading H
Para-G

× × × × ○

  Black Shading H
Para-B

× × × × ○

  Black Shading V
Para-R

× × × × ○

  Black Shading V
Para-G

× × × × ○

  Black Shading V
Para-B

× × × × ○

Continued

*1: –6 dB to +12 dB
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

 Auto Black
Shading

 × × × × ×

Black set  Black Set-R × × × × ○

 Black Set-G × × × × ○

 Black Set-B × × × × ○

Test Test1 on
(TEST SAW)

 × × × × ×

Test2 ON  × × × × ×

Test2 Mode
3step/10step

 × × × × ×

Optical filter Filter1 (ND)  ○ × × × ×

Filter2 (CC)  ○ × × × ×

Filter Remote/
Local

 × × × × ×

5600k 5600K ON  ○ OFF × × ×

White Shading  White Shading H
Saw-R

× × × × ○

  White Shading H
Saw-G

× × × × ○

  White Shading H
Saw-B

× × × × ○

  White Shading V
Saw-R

× × × × ○

  White Shading V
Saw-G

× × × × ○

  White Shading V
Saw-B

× × × × ○

  White Shading H
Para-R

× × × × ○

  White Shading H
Para-G

× × × × ○

  White Shading H
Para-B

× × × × ○

  White Shading V
Para-R

× × × × ○

  White Shading V
Para-G

× × × × ○

  White Shading V
Para-B

× × × × ○

 Auto White
Shading

 × × × × ×

V Modulation V Mod Shad-
ing OFF

 × ON × × ×

 Mod Shading V
Saw-R

× × ○ × ×

  Mod Shading V
Saw-G

× × ○ × ×

  Mod Shading V
Saw-B

× × ○ × ×

  Master V Mod Saw × × ○ × ×

 Dynamic
Shading Com-
pensation ON

 × × × × ×

Continued
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

White  White-R ○ ○ OFFSET × ×

  White-G ○ ○ × × ×

  White-B ○ ○ OFFSET × ×

  color temp — — — — —

  balance — — — — —

  Master White Gain × × × × ×

 Auto White
Balance

 × × × × ×

Flare Flare OFF  ○ ON × × ×

  Flare-R ○ ○ ○ × ×

  Flare-G ○ ○ ○ × ×

  Flare-B ○ ○ ○ × ×

Black  Master Black ○ ○ × × ×

  Black-R ○ ○ × × ×

  Black-G ○ ○ × × ×

  Black-B ○ ○ × × ×

 Auto Black
Balance

 × × × × ×

Detail Detail Off  ○ ON × × ×

  Detail Level ○ ○ × × ×

  Detail Limiter ○ × × × ×

  Detail White Limit-
er

○ ○ × × ×

  Detail Black Limit-
er

○ ○ × × ×

  Detail Crispening ○ ○ × × ×

  H Detail Frequency ○ ○ × × ×

  Mix Ratio ○ ○ × × ×

 V DTL control
mode

 × ○ × × ×

  Detail H/V Ratio ○ ○ × × ×

 Level Dep. Off  ○ ○ × × ×

  Detail Level De-
pend

○ ○ × × ×

 Knee Aperture
On

 ○ ○ × × ×

  Knee Aperture ○ ○ × × ×

HD Detail Detail Off  ○ ON × × ×

  Detail Level ○ ○ × × ×

  Detail Limiter ○ × × × ×

  Detail White Limit-
er

○ ○ × × ×

  Detail Black Limit-
er

○ ○ × × ×

  Detail Crispening ○ ○ × × ×

  H Detail Frequency ○ ○ × × ×

  Detail H/V Ratio ○ ○ × × ×

 Level Dep. Off  ○ ○ × × ×

Continued
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

  Detail Level De-
pend

○ ○ × × ×

Skin Detail Skin DTL On  ○ ○ × × ×

 Natural Skin
Detail ON

 ○ ○ × × ×

 Skin gate ON  × × × × ×

 Skin gate
(CCU)

 × × × × ×

 Skin Detail
Auto Hue
(ch1)

 × × × × ×

 Skin Detail
Auto Hue
(ch2)

 × × × × ×

 Skin Detail
Auto Hue
(ch3)

 × × × × ×

 Skin 1 On  ○ ○ × × ×

 Skin 1 Gate On  × × × × ×

  Skin 1 Level ○ ○ × × ×

  Skin 1 Phase ○ ○ × × ×

  Skin 1 Width ○ ○ × × ×

  Skin 1 Sat ○ ○ × × ×

  Skin 1 Y Limit ○ ○ × × ×

 Skin 2 On  ○ ○ × × ×

 Skin 2 Gate On  × × × × ×

  Skin 2 Level ○ ○ × × ×

  Skin 2 Phase ○ ○ × × ×

  Skin 2 Width ○ ○ × × ×

  Skin 2 Sat ○ ○ × × ×

  Skin 2 Y Limit ○ ○ × × ×

 Skin 3 On  ○ ○ × × ×

 Skin 3 Gate On  × × × × ×

  Skin 3 Level ○ ○ × × ×

  Skin 3 Phase ○ ○ × × ×

  Skin 3 Width ○ ○ × × ×

  Skin 3 Sat ○ ○ × × ×

  Skin 3 Y Limit ○ ○ × × ×

Matrix Matrix Off  ○ ○ × × ×

 Preset Matrix
on

 ○ ○ × × ×

 Preset Matrix
Sel

 × × × × ×

 User Matrix on  ○ ○ × × ×

  R-G ○ ○ × × ×

  R-B ○ ○ × × ×

  G-R ○ ○ × × ×

  G-B ○ ○ × × ×

  B-R ○ ○ × × ×

  B-G ○ ○ × × ×

Continued
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

 Multi Matrix
On

 ○ ○ × × ×

  gate × × × × ×

  Phase select × × × × ×

  Hue ○ ○ × × ×

  Saturation ○ ○ × × ×

 Adaptive Ma-
trix On

 ○ ○ × × ×

 Adaptive Ma-
trix Level

 ○ ○ × × ×

Digital liner
saturation

saturation on  ○ ○ × × ×

 saturation ○ ○ × × ×

OHB matrix OHB Matrix
On

 × ○ × × ×

  Phase select × × × × ×

  Hue × × × × ○

  Saturation × × × × ○

Black Gamma Black Gamma
On

 ○ ○ × × ×

  R Black Gamma ○ ○ × × ×

  G Black Gamma ○ ○ × × ×

  B Black Gamma ○ ○ × × ×

  M Black Gamma ○ ○ × × ×

 Black Gamma
(RGB) Range

 ○ ○ × × ×

Low key satu-
ration

Low Key Satu-
ration ON

 ○ ○ × × ×

 Range  ○ ○ × × ×

  Low Key Saturation
level

○ ○ × × ×

Gamma Gamma Off  ○ ON × × ×

 Gamma Cate-
gory Select

 ○ ○ × × ×

 STANDARD
Gamma Table
Select

 ○ ○ × × ×

 HYPER Gam-
ma Table Se-
lect

 ○ ○ × × ×

 Cine Gamma
Table Select

 ○ ○ × × ×

 User Gamma
Table Select

 ○ ○ × × ×

 Step Gamma
(0.90 to 0.35)

 ○ ○ × × ×

  R Gamma ○ ○
(RGB
mode)

× × ×

  G Gamma ○ ○ × × ×

  B Gamma ○ ○
(RGB
mode)

× × ×

Continued
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

  M Gamma ○ ○ × × ×

Knee Knee Off  ○ ○ × × ×

  R Knee point ○ ○ × × ×

  G Knee point ○ ○ × × ×

  B Knee point ○ ○ × × ×

  M Knee point ○ ○ × × ×

  R Knee Slope ○ ○ × × ×

  G Knee Slope ○ ○ × × ×

  B Knee Slope ○ ○ × × ×

  M Knee Slope ○ ○ × × ×

 Knee Max On  × OFF × × ×

 Knee Satura-
tion on

 ○ ○ × × ×

  Knee saturation ○ ○ × × ×

 Auto Knee
(DCC) on

 ○ ○ × × ×

  Auto Knee Point
Limit

○ ○ × × ×

  Auto Knee Slope ○ ○ × × ×

White Clip White Clip Off  ○ ON × × ×

 R White Clip ○ ○ × × ×

 G White Clip ○ ○ × × ×

 B White Clip ○ ○ × × ×

 M White Clip ○ ○ × × ×

Noise Sup-
pression

Noise Sup-
pression ON

 ○ ○ × × ×

Level  ○ ○ × × ×

Mono Color Mono Color
On*1

 ○ OFF — — —

 Mono Color Satura-
tion*1

○ ○ — — —

 Mono Color Hue*1 ○ ○ — — —

SD Detail SD Detail
Off*1

 ○ ○ — — —

  SD Detail Level*1 ○ ○ — — —

  SD Detail Limiter*1 ○ ○ — — —

  SD Detail White
Limiter*1

○ ○ — — —

  SD Detail Black
Limiter*1

○ ○ — — —

  SD Detail Crispen-
ing*1

○ ○ — — —

  SD H Detail Fre-
quency*1

○ ○ — — —

  SD Detail H/V Ra-
tio*1

○ ○ — — —

  SD Detail Level De-
pend*1

○ ○ — — —

Continued

*1: Connected with CCU only
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Function Switch item Analog item Scene
file

Reference
file

Lens file Operator
file

OHB file

  SD Detail Comb*1 ○ ○ — — —

Cross Color
Reduce

Cross Color
Reduce Off*1

 ○ ○ — — —

 Cross Color Reduce
Level*1

○ ○ — — —

 Cross Color Reduce
Coring*1

○ ○ — — —

SD Matrix SD Matrix
Off*1

 ○ ○ — — —

 SD Preset Ma-
trix On*1

 ○ ○ — — —

 SD User Ma-
trix On*1

 ○ ○ — — —

  R-G*1 ○ ○ — — —

  R-B*1 ○ ○ — — —

  G-R*1 ○ ○ — — —

  G-B*1 ○ ○ — — —

  B-R*1 ○ ○ — — —

  B-G*1 ○ ○ — — —

 SD Multi Ma-
trix On*1

 ○ ○ — — —

  Phase select*1 × × — — —

  Hue*1 ○ ○ — — —

  Saturation*1 ○ ○ — — —

SD Gamma SD Gamma
Off*1

 ○ ON — — —

 SD M Gamma*1 ○ ○ — — —

Level auto set
up

level auto set
up

 × × × × ×

White Setup
Mode

 × × × × ×

Digital extend-
er

digital extend-
er on

 × × × × ×

Menu Item Scene file Refer-
ence file

Lens file Operator
file

OHB file

USER MENU customize  — — — ○ —

Continued

*1: Connected with CCU only
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Menu Item Scene file Refer-
ence file

Lens file Operator
file

OHB file

VF DISPLAY EX — — — ○ —

ZOOM — — — ○ —

DISP — — — ○ —

FOCUS — — — ○ —

ND — — — ○ —

CC — — — ○ —

5600K — — — ○ —

IRIS — — — ○ —

GAIN — — — ○ —

SHUTTER — — — ○ —

BATT — — — ○ —

RETURN — — — ○ —

MESSAGE — — — ○ —

FOLLOW F — — — ○ —

FOCUS NAME — — — ○ —

FOCUS FORM — — — ○ —

VF MARKER MARKER — — — ○ —

LEVEL — — — ○ —

CENTER — — — ○ —

SAFETY ZONE — — — ○ —

EFFECT — — — ○ —

ASPECT — — — ○ —

MASK — — — ○ —

SAFETY — — — ○ —

VF DETAIL VF DETAIL — — — ○ —

CRISP — — — ○ —

FREQUENCY — — — ○ —

FLICKER — — — ○ —

AREA — — — ○ —

ZOOM LINK — — — ○ —

COLOR DETAIL — — — ○ —

PEAK COLOR — — — ○ —

CHROMA LEVEL — — — ○ —

RETURN DISABLE — — — ○ —

FOCUS POSITION ME-
TER1

FOCUS POSITION ME-
TER

— — — ○ —

NEAR LIMIT — — — ○ —

FAR LIMIT — — — ○ —

DIRECTION — — — ○ —

SIZE — — — ○ —

RULED LINE — — — ○ —

INDEX COLOR — — — ○ —

INDEX WIDTH — — — ○ —

MARKER WIDTH — — — ○ —

Continued
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Menu Item Scene file Refer-
ence file

Lens file Operator
file

OHB file

FOCUS POSITION ME-
TER2

ADJUSTED SIGN      

SENSE — — — ○ —

NAME DISP — — — ○ —

FRAME DISP — — — ○ —

FRAME WIDTH — — — ○ —

MARKER CONFIG      

DISP MKR1, 2, 3 — — — ○ —

COLOR MKR1, 2, 3 — — — ○ —

NAME MKR1, 2, 3 — — — ○ —

POS MKR1, 2, 3 — — — ○ —

FOLLOW FOCUS FOLLOW FOCUS — — — ○ —

OFFSET ADJUST SENS — — — ○ —

OFFSET CANCEL GAIN — — — ○ —

FOCUS ASSIST INDICATOR — — — ○ —

MODE — — — ○ —

LEVEL — — — ○ —

GAIN — — — ○ —

OFFSET — — — ○ —

AREA MAKER — — — ○ —

SIZE — — — ○ —

POSITION — — — ○ —

POSITION H — — — ○ —

POSITION V — — — ○ —

ZEBRA ZEBRA — — — ○ —

ZEBRA1      

LEVEL — — — ○ —

WIDTH — — — ○ —

ZEBRA2 — — — ○ —

CURSOR CURSOR — — — ○ —

LEVEL — — — ○ —

BOX/CROSS — — — ○ —

H POSITION — — — ○ —

V POSITION — — — ○ —

WIDTH — — — ○ —

HEIGHT — — — ○ —

BOX MEMORY — — — ○ —

H POSI — — — ○ —

V POSI — — — ○ —

WIDTH — — — ○ —

HEIGHT — — — ○ —

Continued
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Menu Item Scene file Refer-
ence file

Lens file Operator
file

OHB file

SPIRIT LEVEL INDICATOR — — — ○ —

MODE — — — ○ —

REVERSE — — — ○ —

SCALE — — — ○ —

H POSITION — — — ○ —

V POSITION — — — ○ —

ANGLE      

OFFSET — — — ○ —

VF OUT VF OUT — — — ○ —

CHARACTER LEVEL — — — ○ —

PinP — — — ○ —

POSITION — — — ○ —

SIZE — — — ○ —

MODE — — — ○ —

SWITCH ASSIGN LENS      

VTR S/S — — — ○ —

RET — — — ○ —

D-SUB      

ASSIGN1 — — — ○ —

ASSIGN2 — — — ○ —
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Section 8
Setup Menu

8-1. Overview of Setup Menu

Some of adjustments given in this section use the setup menu. The setup menu consists of the following menus.
Besides there is a TOP menu indicating the entire configuration of menu items.

• USER menu
• USER MENU CUSTOMIZE menu
• ALL menu
• OPERATION menu
• PAINT Menu
• MAINTENANCE Menu
• FILE Menu
• DIAGNOSIS menu
• SERVICE Menu

8-1-1. How to Display the SERVICE Menu/How to Change the Setting Values

Displaying the SERVICE menu.

1. Display the MAINTENANCE menu.
2. Set the cursor at [AUTO SETUP] on MAINTENANCE menu and press the MENU SEL knob/ENTER button for

at least 10 seconds.
The cursor shifts to [AUTO BLACK].

3. Set the DISPLAY/MENU switch to OFF, and then turn the switch to the MENU side again.
The SERVICE menu is displayed.

Changing Setting Values

• Select a menu item by turning the MENU SEL knob/ENTER button and it is entered by pressing the MENU SEL
knob/ENTER button.

• For items whose values can be modified by turning the MENU SEL knob/ENTER button, set values can be entered
or suspended by the following operations.
To enter:
Press the MENU SEL knob/ENTER button.
To suspend:
Set the DISPLAY/MENU switch to OFF.
To restart the setting operation, turn the DISPLAY/MENU switch to the MENU side again.

Exiting menu

Set the DISPLAY/MENU switch to OFF.

8-1-2. Settable Special Function

The following function is made available by setting it by the SERVICE menu.
Not that this function is limited.
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• Settings of the number of scene files, setting of the resume of filter position, etc. (Refer to “8-2. SERVICE Menu”
SET UP.)

• Enhancing of master gain, etc. (Refer to “8-2. SERVICE Menu” OPTION.)
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8-2. SERVICE Menu

8-2-1. Description of SERVICE Menu

SET UP

<SET UP>             S01 TOP

 SCENE FILE TYPE :   5

 FILTER RESUME   : OFF

 LENS IF MODE    : AUTO

 RET TRANSITION TIME : 12

ITEM Description Factory Setting

SCENE FILE TYPE Setting for the number of scene files that the camera can have.
5: Five scene files can be set.
32: 32 scene files can be set.

Note
When the setting is changed from 32 to 5 scene files, data of the
sixth and subsequent scene files is deleted.

5

FILTER RESUME When the FILTER LOCAL button is set to ON and OFF, the
filter position of camera is decided by this setting.
ON: Filter position before the FILTER LOCAL button is set to
ON.
OFF: Filter position is not changed.

OFF

LENS IF MODE This item can forcibly change the interface to parallel interface
when a lens that allows serial communication with the camera
is in use.
AUTO: Automatic interface setting
PARA: Forcible setting to parallel interface

AUTO

RET TRANSITION TIME Set the muting time to be inserted when using the RET2 switch
after using RET1 switch.
If the muting time is short, the noise may be appeared at the time
of changing from RET1 to RET2.

12

CC FILTER

<CC FILTER>          S02 TOP

 A: 3200
 B: 3200
 C: 4300
 D: 6300

When the CC filter is replaced with a nonstandard color temperature conversion filter, change this setting.
However, when the CC filter is replaced with a filter without color temperature conversion, such as cross filter, set
3200K. This setting is a reference for color temperature display and the color temperature control function.
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MANUAL RPN

<MANUAL RPN>         S03 TOP

 RPN CH SELECT   :     R
 RPN CURSOR      :   OFF
 CURSOR H POS.   :  1006
 CURSOR V POS.   :   575
 CURSOR JUMP     :  CURR
 RECORD RPN      :  EXEC
 DELETE RPN      :  EXEC

This menu is used for manual RPN compensation. For details, refer to “5-6-2. Manual RPN Compensation Adjustment”.

RPN MANAGE

<RPN MANAGE>         S04 TOP

 RPN ALL PRESET  :  EXEC
 AUTO CONCEAL    :  EXEC
 APR AT ABB      :  ON

This menu is used for RPN compensation setting and management. For details, refer to “5-6-1. Automatic Compensation
(APR)”.

OHB-ADJ1

<OHB-ADJ1>           S05 TOP

 1080-59.94i[4:2:2]
           [R1][G1][B1]
 GAIN_CONT: C7  A9  B1
           [R2][G2][B2]
 GAIN_CONT: C2  A2  A6

 FILTER   :  ON
 STORE FILE:    EXEC

This menu is used for adjustment of the prism block. For details, refer to “5-3-2. Sensitivity Adjustment”.
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BLACK SHADING

<BLACK SHADING>      S06 TOP

 1080-59.94i[4:2:2]
          [R] [G] [B]
 V SAW  :  01  00  03
 V PARA :  FF  FF  FF
 H SAW  :  00  00  00
 H PARA :  01  01  02
 BLK SET:  00  01  19
  OFFSET:  01  00  FB
 GAIN:   0dB
 STORE FILE:    EXEC

This menu is used for adjustment of the black shading. For details, refer to the following sections.
• “5-3-1. Black Set Adjustment”
• “5-3-3. Black Shading Adjustment”

WHITE SHADING

<WHITE SHADING>      S07 TOP

           [R]  [G]  [B]
 V SAW  :   F6   0F   06
 V PARA :   F6   F4   F5
 H SAW  :   0C   FA   04
 H PARA :   FA   F6   F7
 WHITE  :    0    0    0

 STORE FILE:   EXEC
 COLOR TEMP SEL: 3200K

This menu is used for adjustment of the white shading. For detail, refer to “5-3-2. Sensitivity Adjustment”.

SERIAL NO.

<SERIAL NO.>         S08 TOP

 MODEL: HDC-P43
 NO   : 10001

 OHB TYPE : OPTION BASIC

This menu is used displaying the current model name, serial number and the OHB type.
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OPTION

<OPTION>             S09 TOP

 GAIN EXTEND     : OFF
 CHROMA FILTER   : FULL
 VR OVERFLOW     : OFF

ITEM Description

GAIN EXTEND Master gain is enhanced.
ON: –6, –3, 0, 3, 6, 9, 12, 18, 24, 30, 36 dB
OFF: –6, –3, 0, 3, 6, 9, 12 dB

CHROMA FILTER This menu is used for setting the chroma filter.

VR OVERFLOW Switch the IRIS knob on the control panel of the RCP-1000/1500 series so that the relative value
mode turns to OFF and the absolute value mode turns to ON.

CUSTOMIZE

For the function expansion in the future.
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Section 9
Circuit Description

9-1. Optical System (OHB Block)

9-1-1. BI-291 Board

This board equips 2/3 inch backside illumination type 4K CMOS image sensor (IC005).
BI-291 boards are used for R, G and B respectively.

9-1-2. IF-1278 Board

This board equips power supply of CMOS image sensor and flash memory for saving the APR data.
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9-2. Signal Processing/Transmission System

9-2-1. DPR-376 Board

The inputted R/G/B signals from CMOS block are adjusted the black shading, the RPN compensation (RPN automatic
compensation [APR], automatic black balance adjustment [ABB]), the electronic shutter, the noise reduction, the master
white and the master gain at the camera signal process LSIs (IC201 to IC203). The main line signals are sent to IC1001.
At IC1001, linear RGB signals that are processed at camera signal process LSIs (IC201 to IC203) are compressed and
are multiplexed the command signal, they are converted to serial electric signal. This serial electric signal is converted
electric to optic and it is sent to BPU4000/BPU4500/HDCU4300.
VF/Moni signal process, embedded audio process and utility system process of each Trunk/Prompter signal, except
picture process on the main line signal are performed at IC1001.
And also serial optic signal from BPU4000/BPU4500/HDCU4300 is converted optic to electric, it separates return and
command signals.
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9-3. Control System

9-3-1. AT-189V Board

This board consists of the CPU (IC200) for the system control and a peripheral device.
This CPU operates by the main program written in the flash memory (IC401).
As for this CPU, it provides with the interface of USB2.0. Storing/reading the setting data and the upgrade are possible
according to USB drive.

9-3-2. SY-449 Board

This board consists of the FPGA (IC701), an interface circuit, and an audio circuit.
The FRAM (IC403, IC404) retains system setup data, paint data, and other data.

FPGA and Interface Circuits
This board contains the interface circuits for control the external inputs/outputs and internal devices of the unit.
FPGA (IC701) and the interface circuits have the following functions.

• Communication with AT-189V board and DPR-376 board by parallel bus
• 700 protocol communication between this unit and the baseband processor unit (BPU: BPU4000/BPU4500) or the

camera control unit (CCU: HDCU4300)
• TRUNK communication (RS-232C)
• I2C communication with the servo motor (optical ND filter) and SW-1705 board
• Serial lens control
• Parallel lens control
• Fan control
• Tally control
• Rotary encoder input
• Generator of the clock signal for audio PLL and A/D converter

Audio Circuits
This board is provided with 1-channel microphone input from EXT I/O connector on SW-1705 board, and contains an
amplifier for microphone input and an A/D converter.
This board also contains circuit for +48 V phantom power. (unsupported AB power)

9-3-3. DR-663 Board

MCU (IC001) acquires the position information of optical ND filter from SE-1093 board and controls the optical ND
filter by the servo motor performing by I2C communication with SY-449 board. The internal memory of MCU stores
the adjustment data of optical ND filter.
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9-4. Power System

9-4-1. PS-921 Board

The unit uses the inputted DC 12V power to DC IN connector (XLR 4-pin).
This board provides the functions of under-voltage and over-voltage cut-off for input power, and function of current
limit for UNREG output.
The power circuit generates +3.7 V, +1.8 V for block power, then supplies power to block.
This board supplies the powers (UNREG, +5.3 V, +3.6V and -5.5 V) to each board, and the powers are converted to
voltage to be used at each board.
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9-5. Interface Boards

9-5-1. CN-3883 Board

This board contains a DC power input connector (XLR 4-pin, male).

9-5-2. CN-3896 Board

This board contains a Network Trunk connector (RJ-45).

9-5-3. IF-1307 Board

This board is provided with 2-channel SDI connector, output the generated SDI signals in DPR-376 board.
HD-Trunk input signal from the SDI 2 connector that is available for input is sent to DPR-376 board.
Generated prompter signal on DPR-376 board is converted to analog signal by IC200.
The converted signal is output to the prompter signal output connector via SW-1705 board.
This board contains PHY for Network Trunk IF, it communicates with DPR-376 board and CN-3896 board, performs
the Network Trunk.

9-5-4. LE-411 Board

This board contains an acceleration sensor (SE001), and send tilt information to SY-449 board.
This board also contains front tally LEDs (red, green).
This board also contains lens connector (12-pin round type, female).

9-5-5. SW-1705 Board

This board contains switches (POWER, DISPLAY/MENU) and rotary encoder (MENU) on rear panel.
This board also contains rear tally LEDs (red, blue, green) and indicators (POWER, NETWORK, CONDITION).
This board also contains prompter output connector (BNC), USB connector (USB 2.0 type A 4-pin) and external input/
output connector (EXT I/O: D-sub, 15-pin).
DC fan is connected.
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Section 10
Spare Parts

10-1. Note on Repair Parts

1. Safety Related Components Warning
w
Components marked ! are critical to safe operation. 
Therefore, specified parts should be used in the case 
of replacement.

!

2. Standardization of Parts
Some repair parts supplied by Sony differ from those 
used for the unit. These are because of parts common-
ality and improvement.

3. Stock of Parts
Parts marked with “o”  at SP (Supply Code) column 
of the spare parts list may not be stocked. Therefore, 
the delivery date will be delayed.

4. Harness
Harnesses with no part number are not registered as 
spare parts.

1. 安全重要部品
! 警告

 ! 印のついた部品は安全性を維持するために重
要な部品です。したがって，交換する時は必ず
指定の部品を使ってください。

2. 部品の共通化
ソニーから供給する補修用部品は，セットに使われ
ているものと異なることがあります。
これは部品の共通化，改良等によるものです。

3. 部品の在庫
部品表の SP（Supply code）欄に “o” で示される部品
は在庫していないことがあり，納期が長くなること
があります。

4. ハーネス
部品番号の記載されていないハーネスは，サービス
部品として登録されていません。
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10-2. Exploded Views

Overall-1

3

4

5 6

6

8

10

1

6
9

912

1213

2

15

7

7

B2 x 5

B2 x 5

No.  Part No. SP Description

1  A-2178-388-A s DPR-376 COMPL
2  A-2178-391-A s PANEL (R) ASSY, SIDE
3  A-2178-392-A s PANEL (L) ASSY, SIDE
4 ! 1-458-776-21 s MODULE, OPTICAL(SFP+)
5  2-279-715-21 s RIVET, NYLON

6  2-640-315-02 o SCREW (M2X5), SMALL, +P, SW
7  3-603-679-02 s STAINLESS SCREW +B3X10
8  4-382-854-01 s SCREW (M3X8), P, SW (+)
9  4-409-534-01 s SHEET, PS CASE THERMAL
10  4-468-138-02 s FOAM (7X2), SHIELD

12  4-584-940-01 s SHEET, SLIDE
13  4-587-426-01 s SHEET (2 (35X35)), RADIATION
15  4-688-996-01 s PANEL, BOTTOM

  7-621-772-20 s SCREW +B 2X5
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Front Block

102105

105

109

101
103

110

112

112

114

104

106

107

108

109

SW3, 
TYPE2

W3, 
SMALL

B2 x 5

B2 x 5

No.  Part No. SP Description

101  A-2170-621-A s LE-411 MOUNT
102  1-971-527-11 s HARNESS, SUB (FRONT)
103  1-971-528-11 s HARNESS, SUB (LENS)
104  2-623-773-11 s BOLT (M3X8), STAINLESS
105  2-640-315-02 o SCREW (M2X5), SMALL, +P, SW

106  3-657-841-31 o SPACER (2X2.5)
107  3-796-982-03 s HOLDER, LENS MOUNT
108  4-138-678-01 s CLAMP, CABLE
109  4-138-679-01 s SCREW, BLIND
110  4-170-403-01 s COVER, TALLY

112  4-442-619-32 s FORM, SHIELD
114  4-688-994-01 s PANEL, FRONT

  7-621-772-20 s SCREW +B 2X5
  7-623-208-22 s SW 3,TYPE 2
  7-688-003-02 o W3, SMALL
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OHB Block

Attached screws

201

202

203

204

205

206

206

206

207

207

207

216

208

209

210

211

212

213

214

K2 x 3

B2 x 5

K2 x 3

No.  Part No. SP Description

201  A-1813-088-A s DR-663 COMPL
202  A-2076-813-A s IF-1278 MOUNT
203  A-2081-672-A s FD ASSY
204  A-2178-390-A s CMOS BLOCK ASSY (RP)
205  1-856-701-11 s OPTICAL FILTER UNIT

206  1-970-786-11 s HARNESS, SUB (BI-IF)
207  1-970-787-11 s WIRE,CONNECTOR WITH LEAD
208  1-970-788-11 s HARNESS, SUB (CIS-PWR)
209  2-640-315-02 o SCREW (M2X5), SMALL, +P, SW
210  3-699-048-01 s CAP, MOUNT

211  3-776-897-02 s GUIDE PLATE
212  4-263-184-04 s RING, BAYONET
213  4-264-474-01 s BOLT,BHS M2X15
214  4-562-323-01 s LEVER, MOUNT
216  4-414-140-01 s GASKET (3X7) (L=45)

  7-621-772-20 s SCREW +B 2X5
  7-627-452-18 s SCREW,PRECISION +K 2X3
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Overall-2

301

305

302

306

309

310

303

311

311

311

304 311

311

311

307

313

311

314

314

314

308

315

316

317

318

319

319

317

319

312

320

321

No.  Part No. SP Description

301  A-2170-628-A s IF-1307 MOUNT
302  A-2178-386-A s SY-449 COMPL
303  A-2178-387-A s AT-189V COMPL
304  A-2178-389-A s PS-921 COMPL
305 ! 1-756-134-16 s BATTERY, LITHIUM (SECONDARY)

306  1-831-122-11 s CABLE, FLEXIBLE FLAT (50 CORE)
307  1-849-778-11 s SC-LC OPTICAL FIBER CABLE
308  1-971-525-11 s HARNESS, SUB (SY)
309  1-971-529-11 s HARNESS, SUB (DPR2)
310  1-971-530-11 s HARNESS, SUB (DPR1)

311  2-640-315-02 o SCREW (M2X5), SMALL, +P, SW
312  3-079-115-01 s TAPE AS
313  3-603-679-02 s STAINLESS SCREW +B3X10
314  3-742-419-01 o CLAMP, HARNESS
315  4-382-854-01 s SCREW (M3X8), P, SW (+)

316  4-414-114-01 s PAD (SLOT), HEAT CONDUCT
317  4-468-534-02 s FOAM (10X5), SHIELD
318  4-584-992-01 s SUPPORT (2SQ-13)
319  4-641-552-01 o SADDLE, LOCK EDGE
320  4-688-996-01 s PANEL, BOTTOM

321  4-544-481-01 s SHEET (VF), CM RADIATION
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Rear Block

401

402

403

404

405

406

407

408

409

410

411
412

413

426

414

414

414

414

415

416

416

414

417

418

419

420

421

421
422

423

424

425

425

No.  Part No. SP Description

401  A-2170-622-A s CN-3896 MOUNT
402  A-2170-626-A s SW-1705 MOUNT
403  A-2170-627-A s CN-3883 MOUNT
404  1-784-240-11 s CONVERTER, COAXIAL CONNECTOR
405  1-839-914-11 s CABLE, CONNECTOR WITH COAXIAL

406  1-843-839-11 s SC-ST OPTICAL FIBER ADAPTOR
407  1-849-299-11 s CABLE, FLEXIBLE FLAT (30 CORE)
408 ! 1-855-154-11 s FAN, DC (60 SQUARE)
409  1-968-301-11 s HARNESS, COAXIAL
410  1-970-794-11 s COAXIAL CABLE WITH CONNECTOR

411  1-971-526-11 s HARNESS, SUB (XLR)
412  1-971-527-11 s HARNESS, SUB (FRONT)
413  1-971-531-11 s HARNESS, SUB (REAR)
414  2-640-315-02 o SCREW (M2X5), SMALL, +P, SW
415  3-673-910-32 s SCREW, CONNECTOR

416  3-719-381-22 s SCREW (M2X6)
417  3-742-419-01 o CLAMP, HARNESS
418  4-138-683-02 s KNOB, ENCODER
419  4-170-412-02 s GUIDE, LIGHT
420  4-382-854-01 s SCREW (M3X8), P, SW (+)

421  4-442-619-32 s FORM, SHIELD

No.  Part No. SP Description

422  4-559-446-02 s SCREW, +P2.6X5 NEW TRUSTER
423  4-579-333-01 s CAP, ST CONNECTER
424 ! 4-688-995-01 s PANEL, REAR
425  4-689-064-01 s CUSHION, FAN

426  3-869-842-01 s CAP,SW
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10-3. Supplied Accessories 

Q'ty Part No. SP Description

1pc  4-170-413-01 s PLATE, NUMBER
1pc ! 4-689-988-01 s CD-ROM PACK
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Section 11
Diagrams
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